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2 Disclaimer

The actual version of this product (document) is available as is. TEC-IT declines all warranties
which go beyond applicable rights. The licensee (or reader) bears all risks that might take place
during the use of the system (the documentation). TEC-IT and its contractual partner cannot be
penalized for direct and indirect damages or losses (this includes non-restrictive, damages through
loss of revenues, constriction in the exercise of business, loss of business information or any kind of
commercial loss), which is caused by use or inability to use the product (documentation), although
the possibility of such damage was pointed out by TEC-IT.

% We reserve all rights to this document and the information contained therein. Reproduction,
use or disclosure to third parties without express authority is strictly forbidden.

B Fur dieses Dokument und den darin dargestellten Gegenstand behalten wir uns alle Rechte
vor. Vervielfaltigung, Bekanntgabe an Dritte oder Verwendung auf3erhalb des vereinbarten
Zweckes sind nicht gestattet.

© 1998-2010
TEC-IT Datenverarbeitung GmbH
Wagnerstr. 6

A-4400 Austria

t.: +43 (0)7252 72720

f.. +43 (0)7252 72720 77
http://www.tec-it.com
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3 Introduction

3.1 Whatis TBarCode?

TBarCode is a set of professional tools for the generation of barcodes. More than 100 different
symbologies (linear barcodes, 2D barcodes and stacked barcode variants) can be printed or
exported as graphics files. All industry formats are supported. The barcodes can be generated in
the highest possible resolution and quality.

TBarCode is available in several versions for different operating systems, applications and
programming environments. The following versions are included in this setup:

TBarCode OCX A Microsoft® ActiveX® compliant barcode control. It can be used with
Microsoft® Office applications as well as by software developers.

TBarCode .NET A .NET barcode library for software developers. It includes barcode
controls for Windows Forms and ASP.NET 2.0.

TBarCode Library | A DLL for Windows platforms for software developers.

(A DLL for Windows CE/Windows Mobile is available on request. Please
contact us with your platform details.)

3.2 Scope of this Document

This document concentrates on the use of TBarCode OCX in Microsoft Office applications.

In contrast to the other two components (TBarCode .NET, TBarCode Library) TBarCode OCX
may be used without any programming knowledge. This makes it easy to use and you will get
results in quasi no time. Using the OCX control you can integrate bar codes in text documents,
spreadsheets and the like. First insert the barcode object in the desired document. Then adjust the
barcode properties (barcode type, data, etc.) in the provided dialogs.

The first part of the document explains how to use TBarCode OCX in Office Applications like Word,
Excel, Access and InfoPath. A few simple examples also demonstrate the possibility of pro-
gramming the control in Visual Basic for Applications.

The second part of this document describes all available barcode properties, which can be adjusted
in the property dialogs. All of these parameters are described in detail.

If you are a software developer and if you are interested in integrating barcode features into your
own applications please check out the accompanying developer manuals, developer references
and sample applications (see Appendix A).

3.3 What is TBarCode OCX?

TBarCode OCX is a Microsoft® ActiveX® compliant barcode control. Such an ActiveX control is
sometimes called OLE control or OCX control. In German it is named "Steuerelement”.

You can use TBarCode OCX in:

= Microsoft® Office: barcodes are embedded into documents, forms or databases easily.

= Development environments: integrate barcodes into your own application(s).

= Report-Generators and Reporting Engines: Enhance the output with barcode functionality.
=  Web Applications: Use barcode technique as part of browser-based applications.
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Most programming and script languages.

Examplesl, where you can use TBarCode OCX for barcode generation:

= Microsoft Word = Microsoft ASP (VBScript®) = Borland Quick Reports®

= Microsoft Excel® = Microsoft Internet Explorer® = Sybase® PowerBuilder

= Microsoft Access® = Microsoft Visual FoxPro® = Crystal Reports® 8

= Microsoft InfoPath® = Microsoft Dynamics Nav® = ActiveReports (Data Dynamics)
= Microsoft SharePoint® = Navision Financials® = |BM® Object REXX®

= Microsoft Visio® = PHP 4.x, PHP 5.x = Alpha Five Database (XBasic)

= Microsoft Visual Basic® = Borland C++ Builder® = ASNA Visual RPG®

= Microsoft Visual C++® = Borland Delphi® = And a lot of more applications...
3.4 Restrictions of the Demo Version

In the demo version the barcodes will be drawn with a demo-hint. That means that the word “Demo”
or the phrase “www.tec-it.com” is drawn partially over the barcode. The demo-hint does not influ-
ence the readability of the barcode in a negative way.

>

>

>

In special cases (e.g. very small or high-resolution barcodes) you may want to test the pro-
duct without restrictions. To obtain a temporary license key contact sales@tec-it.com.

For enabling the full-featured version (without the demo hints) you can obtain a license key
from TEC-IT (http://www.tec-it.com/order/).

For more information on licensing TBarCode, please refer to chapter 11.

3.5

Important Security Notice

Version 8.0 and newer versions include a fix which was implemented in response to a
security leak (a malicious web-site in conjunction with Internet Explorer and an installed
TBarCode ActiveX). Up to now no real threat is known, but it is strongly recommended to
update all TBarCode installations as soon as possible.

! For applications not supporting ActiveX technology you may use other TEC-IT Barcode Tools (e.g. Barcode Studio).
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4 |nstallation

4.1 Requirements

The following operating systems are supported:

=  Microsoft Windows 2000

=  Microsoft Windows XP

= Microsoft Windows Server 2003

= Microsoft Windows Vista

=  Microsoft Windows Server 2008
Microsoft Windows 7

TBarCode OCX was tested with the following Microsoft Office versions (in particular with Microsoft
Word, Excel, Access, Visio® and InfoPath®):

= Microsoft Office 97*

= Microsoft Office 2000

= Microsoft Office 2002/XP
= Microsoft Office 2003

= Microsoft Office 2007

4.2 Download and Setup

Download TBarCode from http://www.tec-it.com/Download » TBarCode and execute the setup
application. Depending on your selection one or more of the following components are installed —
along with documentations and sample applications:

= TBarCode OCX
A barcode ActiveX control for Microsoft Office users and for software developers. User
manual and API reference are included in the setup.
= TBarCode Library
For software developers. Developer manual and API reference are included in the setup.
= TBarCode .NET
For .NET developers. Developer manual and API reference are included in the setup.

> Administrative rights are required to install TBarCode.

» TBarCode OCX is an ActiveX control. ActiveX controls must be registered within the Micro-
soft Windows operating system before they can be used. This registration is executed auto-
matically by the setup application. On demand you can register the OCX file manually with
the command line tool “regsvr32.exe”.

2 For Office 2003 and higher
® For Office 2003 and higher
“ Excel ’97 is only supported by TBarCode4
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5 Insert Barcode

5.1 General (Microsoft Office)

This and the following chapters will explain how to use TBarCode in Microsoft Office applications.
For the following three products the usage of the TBarCode control is basically the same (see
TBarCode QuickStart manual):

=  Microsoft Word 2003 (and earlier versions)
=  Microsoft Excel 2003 (and earlier versions)
=  Microsoft Access 2003 (and earlier versions)

In Office 2007 inserting the TBarCode control has slightly changed. How to do this is explained in
sections 5.5, 5.6 and 5.7:

= |nsert Barcode in Microsoft Word 2007
= |nsert Barcode in Microsoft Excel 2007
= |nsert Barcode in Microsoft Access 2007

Finally, the usage of TBarCode in Microsoft InfoPath is explained in chapter 9.

5.2 Insert Barcode in Word 2003 using the Menu

I§ Document3 - Microsoft Word SEE
! File Edt Wew | Insett | Formak  Tools  Table  Window  Help Type a question for help = 22
P05 (3 ek b9 -0 -8 40 REEB ST e - @ Heed i

P44 MNormal Rloslubezy Engish(U5) ~ | B I U x* X |§ = = !=-|i= T iE iE | [[ - Bordersand Shading,. ®7 - A - !
e L Date and Time...

|I]]]]New Barcode IHE|D License About !

ButaText 3

E C3 NI - RN A RN+ I f
Eield... 2 (%) =
Symbal,.,
2ymbol Create New | Create from File
~ Comment
. | = Object type:
z Reference 3 Package -
- ) RegWizCrl 1
- 2l web Companent... Snapshat File 9
- o Syskem Monikor Control
: Eoe > T T
- f:? Diagrarn. . TConneckor2 = |:| Display as icon
TFormers
- &5l Text Box video Clip v

1

File... Result

Object . Inserts a new TBarCoded object into your
= document,
Bookmark, -

% Hyperlink...  ChrHE

“HHHH“‘ H“ ®

Adjust Properties

.

B E 4 3 2

7

Figure 1: Insert Barcode using the Menu (Microsoft Word)

Application How to insert
Word = Select Insert » Object... from the menu (0).
= Select TBarCodel0 from the list of object types ® and confirm with OK.
Excel = A new barcode object will be inserted (©).
Access = Open your report (or form) in the design mode (see 6.2).
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= Select Insert B ActiveX Control... from the menu.
= Select TBarCodel0 from the list of object types and confirm with OK.
= A new barcode object will be inserted.

InfoPath Please refer to section 9.4.

5.3 Insert Barcode in Word 2003 using the Control Toolbox

EE' Document3 - Microsoft Word E”EWE
! File Edt Wiew Insett Format  Tools  Table Window  Help Type a question for help =
NSERESRITE L B9 - 8 30 FEEB S e - @ e

A4 Normal ~ TimesMewRoman + 12 - Engish(Us) - | B F U x* X |§ = £ =i iZ iEEIE| ~ Borders and Shading... &7 - A v!

|I]]]] Mew Barcode Fropetties Serial Letter Help License About !

p=|
lz‘ I A N S CO L I TS IR I U S - L A -2 c 7o C: AR - BRI | SR B & B = B E U CACN B P ORI AR B -0 ~

FEEEEE R E R L2

S5Ribbon Control 3.0 ~
STSUpl CopyCtl Class B
] 5T5Upld Upload< Class

SumnmaryRibbon Class

SysColorChrl class

Lk
Syskem Information
System Manitor Control
Tabular Data Contral
Task3ymbol Class
TConnector
: ! TelnetLnk, TenetLink

<€

Adjust Properties 284 conkrols

Figure 2: Insert Barcode using the Control Toolbox (Microsoft Word)

> Please note: In Word and Excel the toolbar is named “Control Toolbox”, in Access just “Tool-

box”.
Application How to insert
Word = If the Control Toolbox @ is not visible, please open it as follows:
Excel - right-click on one of the visible toolbars and select Control Toolbox or
- select View » Toolbars » Control Toolbox from the menu.
Access = Click on the More Controls icon®. — A list with available controls will
appear (see®).
=  Select the entry TBarCode10.
= Now move the mouse cursor to the desired position and click the left
mouse button. The TBarCode control @ will be inserted.
InfoPath Please refer to section 9.4.

5.4 Insert Barcode per Code

Using VBA (Visual Basic for Applications) you can insert the barcode per code. For more informa-
tion, please refer to section 8.3.
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5.5 Insert Barcode in Word 2007

5.5.1  Using the Developer Tab
You can also insert a barcode as follows:

= Click the Office button on the top left of the Word window and then select Word Options.

55 Publish »

!1
Clase

= Enable the Developer tab in the Ribbon:

Popular l

Ty
ﬁ Change the most popular options in Waord.
Display
Proafing Top options for working with Word
Save Show Mini Toolbar on selection (i
Enable Live Preview (i
Advanced : . . X
' iShow Developer tab in the Ribbonii
. gt
Customize / Always use ClearType
Addns Open e-mail attachments in Full Screen Reading view G
Color scheme:
Trust Center E

= Then go to the Developer tab and click Legacy Tools » More Controls. Select TBarCodel0
from the list of ActiveX Controls and confirm with OK. The barcode will be inserted at the
current cursor position.

.'/ﬁg;\ Hw-u = Document3

9 Home Insert Page Layout References Mailings Re

e |:_| ;ﬂ Record Macro Aa Aa |:=| ﬂ M Design Mode l

- =l =22 o pause Recording 3T Properties 1

\Q;:Iiacl Macros I\ Macro Security Se Iﬁ: ﬁ@ 185 Group N
Code Legacy Forms

e — ab) [7] £ 6 7d) (2
SRR |

ActiveX Controls

5.6 Insert Barcode in Excel 2007

= Enable the Developer tab in the Ribbon (Excel Options)

Top options for working with Excel
Show Mini Teolbar on selection (i
Enable Live Preview G ‘/
Show Developer tab in the Rikbon
Always use ClearType
Figure 3: Excel 2007: Excel Options - Show Developer tab
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% Properties E “F Map Properties
G View Code ig.'j Expansicn Packs
Ins:ert [I:T::IJ: # Run Dialog Source i Refresh Data 7
Form Controls | XML More Controls
(= 2 TBarCodeld
1 4« 8 abl [ ER
F G
ActiveX Controls TBarCode3
=@V B 2 TBarCode4
- 5 = 2 *
M 1 TO~rAdAD

Figure 5: Excel 2007: Select TBarCodel0

More Controls

Insert a control from the set of
centrols available on this computer.

Figure 4: Excel 2007: More Controls

= Select TBarCodel0 from the list of object types and confirm with OK.

= Now move the mouse cursor to the desired position and draw a rectangle to the position
where the bar code should be. A TBarCode control will be inserted.

» Please note: In Word 2007 and Excel 2007 the "Control Toolbox” can be found in the
Developer tab, in Access 2007 inside the Design Tab.

For inserting barcodes in Microsoft Excel 2003 use the TBarCode QuickStart manual provided in
the Windows start menu.

5.7 Insert Barcode in Access 2007

= Open a new report in Design View.

o= Labels b= = =
: 2 B f .)0.\‘ :}J [
) [_] Blank Report | == L - Sl
Report X Report | Query Query Macro
K] Report Wizard Design = Wizard Design -
Reports Other

| New Object: Report

Create a new blank report in
Design view.

In Design view, you can make
advanced design changes to
| reports, such as adding custom
| control types and writing code.

= Click the ActiveX Controls symbol in the Design tab Controls section.

)lﬁ_‘_#iﬂﬂtle ab] Aa ﬂﬂ\[ﬁl#nhﬂ:ﬂ =~ ji-Salach

: #] Page Numbers EACIM (3489 | ==- 35 %N Use Control Wizards
Logo . Text  Label Button _ m — -
_E:L!)Date and Time Box ERENol SE 0 R _’?&Actnre){ Controls
Controls

Insert ActiveX Contral I
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= Select TBarCodel0 from the list of ActiveX Controls and confirm with OK.

Insert ActiveX Control

Select an ActiveX Control:

Tabular Data Control
TaskSymbaol Class
TBarCodel0
TBarCode3
TBarCode4
TBarCodes
TBarCode6
TBarCode?
TBarCode8
TBarCoded
TConnector2
TFormer41

TLicense Class
Trimmer Class
VideoRenderCt Class

Result
Inserts a new TBarCodel0 into your document.,

|im|

= A TBarCode control will be inserted.

» For adjusting the barcode properties right click the bar code control and select TBarCodel0
Object » Properties from the context menu (see also 6.3).

For inserting barcodes in Microsoft Access 2003 use the TBarCode QuickStart manual provided in

the Windows start menu.
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6 Adjust Barcode Parameters

6.1 General

TBarCode offers the possibility to change all barcode related settings (barcode type, barcode data,
check digit method, barcode appearance, etc.) to your needs. There are three different methods for
changing barcode parameters. These methods are explained in section 6.3.

> Please keep in mind:

In order to select, move, resize, edit and program the TBarCode control you have to be in
Design Mode. When leaving the design mode, the control is locked and cannot be edited.

6.2 Activate the Design Mode

Application How to activate the Design Mode
Word See section 6.2.1.

Excel

Access See section 6.2.2.

InfoPath See section 9.2.

6.2.1 Microsoft Word or Excel

l-l-g-l

[ B BB B B B - N A
\ \ \ \ \

Adust Properties

Wl | 7 bl = [H[B A

Design Mode

6.2.2 Microsoft Access

§&=  dh1 : Database (Access 2000 file format)
), Preview \%&sign Gl Mew | X | 2 e f

Objects Create report in Design view
=] Tahles Create report by using wizard

_Eﬂ Queries a w

& Print Preview
= Forms ||g Desian i
Design Yiew [X@
| 83 Reports 4 Print
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Switch to Design Mode by clicking on the triangle
symbol @ in the Control Toolbox.

If the control toolbox is not visible, please open it
as follows:
= Right-click on one of the visible toolbars
and select Control Toolbox or
= Select View » Toolbars » Control
Toolbox from the menu.

You can activate the Design Mode when opening
the form (or report):
= Select the desired form (or report) and click
on the Design button @ or
= Right-click on the form/report name and
select Design View (®) from the pop-up
menu.
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6.3 Barcode Parameters

The barcode parameters can be adjusted either by using the Property Pages, the Property List or

VBA Code.

Except for some special settings (which are available in the property list or via code only) TEC-IT
recommends the use of the property pages. The property pages are designed for easy adjustment
of the TBarCode properties.

6.3.1 Property Pages

4

TR g

-]

CERINCIS -SRI E R R F R S A - I |

w

JIBarCode? Properties

Barcode ]Appeafance} Multiple Barcudes] Font ] Color ]

Baszic zettings
Barcode twpe [symbology):

Barcode data Adjust Properties
[ 17 characters)

Advanced seltings

Encoding mode: ‘Cunverl to Code Fage j
LCode page: ‘ Drefault j |
Fommat/Subset: ‘ ¥ Default
Check digit [ Detaut =l
Compression: ‘ MNone j e
[ Suppress enor messages [~ Tianslate escape sequences

License... About...

K. Cancel | | Help

]

= |

Cut

Copy

Adjust Propert]

Paste

Properties

£ 65 £ i <

Wiew Code

o TBarCoded Object » Properties... D\g 9
License. ..

% Format Control. ..

% Hyperlink. .. Conyert. .,

Figure 6: Property Pages (Microsoft Word)

= Right-click on the TBarCode object and select TBarCodel0

Propetrties...

Application How to open the Property Pages
Word = Make sure that you are in Design Mode (see section 6.2).
Excel = Right-click on the TBarCode object ©.
=  Select TBarCodel0 Object » Properties from the pop-up menu (®).
Access .
= The property pages © will appear.
InfoPath = Make sure that you are in Design Mode.

> For detailed information about the property pages and about the available settings, please
refer to chapter 10.

WWW.TEC-IT.COM
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6.3.2  Property List

|TBarCoded1 TEarCoded | 9

Alphabetic ]Categorized ]

(Aabout) ~
(Cusktom)
(Mame) TEar_oded1
. . T oo <
| Backstyle Transparent
Adiust P T paste BarCode Codel25
- 7 Properties 9 BarwidthReduction |0
BarwidthReductionUnit Percent
Qf] Yiew Code EearerBar Type MNone
TBarCoded Chject » EBrearerBariidth -1
—_— CDMethod Defaul:
{?/ Eormat Control... CheckDigits
% Hyperlink... CodePage Default
CodePageCustom 0
CompositeComponent | Default (Mone)
Compression MNone
CountCheckDigits 0
CountModules 222
CountRows 1
Decader Hardware decoder
DefaultSet Defadl: {Mone)
DisplayText
Dpi 300
DrawMade Default
DrawSkatus 0 - eDST_Ok
Frshled Trie b’

Figure 7: Property List (Microsoft Word)

Application How to open the Property List
Word = Make sure that you are in Design Mode (see section 6.2).
Excel = Right-click on the TBarCode object @ and select Properties (8) from
the pop-up menu.
Access As an alternative you can also select the barcode and click on the
Properties icon © in the Control Toolbox.
= The property pages @ will appear.
InfoPath No property list available.
» Some properties — in particular data binding (“Linked Cell” in Excel or “Control Source” in
Access) — are available in the property list only. For more information on data binding,
please refer to section 7.3.

6.3.3  Adjust Parameters per Code

Using VBA (Visual Basic for Applications) you can adjust the barcode parameters per code. For
more information, please refer to section 8.4.
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7 Set Barcode Data (Data Binding)

7.1 General

The barcode data can be provided in three ways:

=  Manually
= Via Data Binding
= Via VBA (Visual Basic for Applications)

7.2 Specify Data Manually
You can specify the barcode data in the property pages or the property list:

7.2.1 Property Pages

| TRarCode10 Properties = Open the property pages (see section
6.3.1).
Barcode ]ﬁq}peamnce] Muttiple Barcodes] Fort: ] Calor ] - Select the “Barcode” tab
Basic gettings

= Enter the desired text in ©.

Barcode type (symbology]: ([0 EE

Barcode data: Adjust Properties

[ 17 characters]
4

7.2.2  Property List

Properties (5] = Open the property list (see
|TBarCode101 TBarCodeln =] section 6.3.2).
Alphabetic | categorized = Select the Text property.
RSS_SegmPerRow 1 ~ . Enter the desired text in 6.
SizeMode Default - Fit to bounding rectar
SuppressErrorMsg False
RN A diust Properties @) .|
TextAlignment Default =
TextBlockHeight 0
TavtBinclAbfidth n 2

7.3 DataBinding

Some Microsoft Office applications provide the option to bind the content of a specified data field to
the TBarCode control (“data binding”). This means that the barcode control will use the content of
the data field as barcode data. Whenever you change the content of the data field the barcode
symbol will be updated as well.

Application Data Binding

Word Not available.

Excel See section 7.3.1.
Access See section 7.3.2.
InfoPath See sections 9.3 to 9.5.

7.3.1 Microsoft Excel

Data binding can be enabled via the property LinkedCell:
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= Make sure that you are in Design Mode (see section 6.2).

= Select the TBarCode object ©@.

= Then click on the Properties icon @ in the Control Toolbox.
(If you have inserted the barcode using the Control Toolbox (see section 5.3) you can alter-
natively right-click on the TBarCode object ® and select Properties from the pop-up menu.)

= The property list © will appear.

= Select the property LinkedCell and enter the name of the cell that you want to bind to the
TBarCode control (see @). In this sample B7 is used.

E3 Microsoft Excel - Book1 CEE
E‘_I] File Edit Wiew Insert Format Tools Data  Window Help Type aquestion forhelp = 2 & 3
PN EE RS EE % RS9 8 8] R 1 v.g.lgg g -
TBarCodedl = fe =EMBED({"TBarCoded TBarCode3.1""") %—
A | = = | nertie: H =
@ 1 L [TBarCoded1 TBarCoded O -l
ﬁ? "—T 9 Alphabetic lCategorized]
Ci:] 4| DefaultSet Defaulk {None) A
[ | 5 | Use the cell below as barcode data: g:;plaﬂex': 00
febl % Encoded Dat DrawMode Default
= ncoded bata Drawstatus 0-eD5T_Ok
@ | 8 | Enabled True
] i Encodingtode Convert to Code Pag
—H ﬂ EscapeSequences False
=B " Fant Arial
— 12 FonkMarne Arial
; 13 FontSize 10
s
=i 14 Foreolar W =H0o000000:
o 15 o o Encnd%d Data =3 Faormat
A | 16 | Height 70,5
17 LastError The operation comple
ﬂ 13 LaskErrorhlo u]
= KT Left 69,75
B ey LinkedCell B7
20
e 7 Locked True
5| Moduletidth 339
ﬁ MustFit False
= Mok chHeight -1 v bt
4 4 » M} Sheetl  Sheet? { Sheeta / K ¥
Ready T

Figure 8: Data Binding in Microsoft Excel

7.3.2 Microsoft Access

The barcode control can be used in reports and forms. Most commonly the barcode is bound to a
table column. If this is done, the barcode changes according to the data record which is currently
being displayed.

In order to bind the barcode to a data source, please execute the following steps:

= Right-click on the TBarCode object ©.

= Select Properties from the pop-up menu @.

= Select the Data tab ©.

= For the property Control Source select the data field (or the query) that serves as source for
the barcode content (see O).
This step is only possible if you have previously defined a data-source for the report/form.
You can do this by opening the properties dialog for the entire report.
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K] Microsoft Access

i Fle Edt View Inssrt Format Tools  Window Help Type a question for help |+

HEAN™ e W= NN e A RN N =] B [ SRS AR SN = =] :J-I@!it&:ﬁ\lhablli‘lr‘- @EEE@JEE@‘%D@\D%‘.!
= Cll=k

i TBarCodess - | U=

¥ Report1 : Report

= Copy of TBarCodelnAccess : D T R L T R R R

& Preview B2 Design ‘g tew | X |  Page Header

— — - TearcCadess () ~|
Tables createreg |1 || el [Deser Barcps | Format | Data | Event | other | al | _

I ActiveX Control: TBarCode96 [x]

Creats rey
i@ Reporti

Queries

Control Sour Teemhumber (g
OLE Class . . TBarCoded
TBar Code9. THarCoded. 1

Forms

: e JII—
- s
ages 8 Buid. ..

Macros

TBarCoded Objsct

Euoghe| o a

Modules Adiust Rroperties

Change To

Groups # Page Footer =

Favorites 3 Copy

Paste

align

Size

Fillffiack Calor

Font{Fare Calor

Sperial Effect:

Hyperlink

Subreport in Rlew Window

“p| Properties

Design Visw HUM

Figure 9: Data Binding in Microsoft Access

> Please ensure that the barcode type corresponds with the data that you want to encode. If
the source string contains characters which cannot be encoded with the selected symbolo-
gy, an error message will be displayed instead of the barcode.

> Hint: You can also enter a fixed value or an expression as data source.
Example: The expression "=[ArticleNo]+[Price]" could be used for concatenating the data
fields ArticleNo and Price for the EAN13 P5.

7.3.3  Specify Data via VBA Code

Using VBA (Visual Basic for Applications) you can specify the barcode data per code. For more
information, please refer to section 8.4.
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8 Programming TBarCode (VBA)

8.1 General

TBarCode can be used in Microsoft Office and all other applications (e.g. development environ-
ments) which support ActiveX controls. The TBarCode object can be inserted as part of any form,
document, report or spreadsheet, or it can be created as (invisible) instance which is used for
printing only.

This chapter gives basic introductions on how to use the TBarCode OCX with VBA. For additional
information and sample applications check out Appendix A.

8.2 Microsoft Office and VBA

In Microsoft Office all barcode properties (barcode type, barcode data, barcode size, etc.) and
methods can be accessed directly via VBA code.

Basically, TBarCode can be inserted in two different ways:

= As OLE Object
= As OLE Control

Inserting TBarCode as OLE Control guarantees that the barcode object provides all properties (e.g.
a name for identification) and interfaces which are necessary for programming. To make sure that
the barcode is inserted as OLE Control you should insert the barcode via the Control Toolbox (see
section 5.3).

Properties (=] Upon insertion the TBarCode control is usually
= named “TBarCodel0n” (where n is a consecu-
tive number). This name can be used for
addressing the TBarCode control in the VBA

|TBarCode101 TBarCodel0
Alphabetic l Categorized
(About)

(Custom) |é| code.

(Name) TBarCodel0gy You can view (and also edit) this name by right-

Active TextIndex 0 . e .
[ aHOOFFFFFFR | clicking on the' respective barcode symbol. Then
Transparent select Properties... from the pop-up menu. The
Code 128 - name of the control is shown in @.

> To edit and to program the TBarCode control the design mode is required. For accessing
the control in your VBA code use the name as assigned in ©.

» Hint: If you double-click the control in design mode the VBA editor is opened (not shown).

» For a list of available properties and methods and for a detailed description of the TBarCode
programming interface, please refer to the developer documentation (see Appendix A).

8.3 Insert Barcode

The following code samples can be used to create and to insert a barcode object in Office applica-
tions. You can execute the code with a macro or you can trigger it with a control event (e.g. button-
click).

WWW.TEC-IT.COM Page 22 of 69
|




Application How to Insert Barcode

Word See section 8.3.1.
Excel See section 8.3.2.
Access No example available.
InfoPath No VBA supported.

8.3.1 Microsoft Word

This sample shows how to insert a Code-128 symbol at the actual cursor position. The barcode
data will be set to “1234567890".

Dim oShape As InlineShape
Dim oTBC As Object

' Insert a shape containing a barcode object at the actual cursor position.
Set oShape = Selection.InlineShapes.AddOLEObject (ClassType:="TBarCodel0.TBarCodelO.1",
FileName:="", LinkToFile:=False, DisplayAsIcon:=False)

' Activate the barcode object.
oShape.OLEFormat.Activate

' Adjust the size of the barcode by adjusting the shape.

' (The barcode object extends to the size of the shape by default).
oShape.Width = 200

oShape.Height = 100

' Get the barcode object within the shape.
Set oTBC = oShape.OLEFormat.Object

' Adjust the barcode object properties (barcode type, barcode data...)
oTBC.BarCode = 20 ' select Code-128 (TBarCodelOLib.eBC Codel28)
oTBC.Text = "1234567890" ' set barcode data

» This samples inserts TBarCode as OLE Object. To insert the barcode as OLE Control you
have to use the command AddOLEControl.

8.3.2 Microsoft Excel

This sample shows how to insert a Code-128 symbol in cell “C3” on the current spreadsheet. The
barcode data will be set to “123456” and the size of the human readable text to 8 points.

Dim TargetCell As Variant ' The cell, in which you want to insert the barcode
Dim CellHeight As Variant ' Height of the target cell

Dim CellWidth As Variant ' Width of the target cell

Dim CellTop As Variant ' Top coordinates of the target cell

Dim CellLeft As Variant ' Left coordinates of the target cell

Dim BCObject As OLEObject ' The TBarCode container object

TargetCell = "C3"

' Make sure that the cell height has 30 pixels minimum
If (Range (TargetCell) .RowHeight < 30) Then

Range (TargetCell) .RowHeight = 30
End If

' Get target cell dimensions
CellHeight = Range (TargetCell) .Height
CellWidth = Range (TargetCell) .Width
CellTop = Range (TargetCell) .Top
CelllLeft = Range (TargetCell) .Left

' Insert barcode object into selected cell

Set BCObject = ActiveSheet.OLEObjects.Add(ClassType:="TBarCodel0.TBarCodelO.1",
Left:=CellLeft,
Top:=CellTop,
Width:=CellWidth,

Height:=CellHeight)
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' Adjust the barcode object properties (barcode type, barcode data...)

BCObject.Object.BarCode = 20 ' select Code-128 (TBarCodelOLib.eBC Codel28)
BCObject.Object.Text = "123456" ' set barcode data
BCObject.Object.FontSize = 8 ' set size of human readable text

> Via VBA code the barcode can only be inserted as OLE Object (not as OLE Control).

8.4 Adjust Barcode Parameters and Barcode Data

Application How to Adjust Barcode Parameters
Word See section 8.4.1.

Excel

Access See section 8.4.2.

InfoPath No VBA supported.

8.4.1 Microsoft Word or Excel

The example below shows basic TBarCode method calls. The barcode object is identified by the
name “TBarCodel01” (see section 8.2).

TBarCodelOl.BarCode = TBarCodelOLib.eBC DataMatrix ' select the barcode type Data Matrix
TBarCodelOl.Text = "Hello World!" ' set the barcode data

8.4.2 Microsoft Access

» To access the barcode properties and methods you have to use the "object" interface.

The example below sets the barcode data (text property) of TBarCode. The barcode object is
identified by the name “TBarCodel01” (see section 8.2)

| TBarCodelOl.Object.Text = "1234567890" ' set the barcode data

8.5 License TBarCode

Call the method LicenseMe() from within your application. Do this before barcodes are generated or
printed. Before calling this function the TBarCode OCX control must be instantiated, otherwise an
error message will be received.

To license TBarCode use the following VBA call:

| TBarCodelOl.LicenseMe "Licensee", eLicKindDeveloper, 1, "LicenseKey", eLicProdlD
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9

Barcodes in Microsoft InfoPath®

9.1

General

In order to use TBarCode in Microsoft InfoPath you have to perform the following steps:

9.2

Open your form in Design Mode (see section 9.2).

Add TBarCode to the Custom Controls (see section 0). This step is required only once. It
enables Microsoft InfoPath to use TBarCode.

During this step you have to specify the data source type for TBarCode. You have to decide
whether you want to encode:

- the content of single data fields or
- the underlying InfoPath XML document (or parts of the XML document).

Insert the barcode (see section 9.4).
Change the data binding (optional) — see section 9.5.
Adjust barcode parameters (see section 9.6).

Activate the Design Mode

Please note: you have to be in Design Mode to add barcodes to a form design, to select, move,
resize and to adjust the barcode parameters.

| & 7 3 |@U R @ ! You can activate the Design Mode by clicking on
Ap——— () i p— the triangle symbol @ in the Standard toolbar. —
. The design view will be opened in a separate

_ Design This Form [

_ e

Crate:

28.09.2006

Location
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9.3

To add TBarCode to the Custom Controls, please follow the steps below:

Add TBarCode to the Custom Controls

= Make sure that you are in Design Mode (see 9.2).
= Open the Task Pane @. Therefore select View » Task Pane from the menu (see 0).

(Design) Templatel - Microsoft Office InfoPath 2003

) 3 Task Pane @), ctrbF1 |

P Fle Edit | Yiew | Insert Format  Tools  Table  Help

|8 (] |l | e Desion Tasks... | (@) !

P

i vein] | o0 SMEEEEE Ty
: ;% Design Tasks...
o] o> EF PR
= %4 Datasource...
E|
@ -
M .3l Manage Yiews...
Servijes
‘Word Prink Views...
Request Sample Data Crate:
°
] Headsr and Footer. ..
Page Width Guide -
Conta Location
Requested By: Office Location:
L: ]
Phone Humber: Space:;
E-rnail Address:
Service Problem
v v

Description

8 -
— : Design Tasks

Type a question for help =

@ @ &
Tasks

08| Layout

Insert areas in wour Form's view
to control layout

'é{"’ Contrals e

&dd controls ko et users enter
data into the form

IJ__1 Data Source

Display and modify the form's
data source

3 views
Create views to define the
appearance of form data
E'E Publish Farm. ..

Distribute the Farm to ather
users by publishing it in a shared
location

@) Help with Design Tasks

Figure 10: Add TBarCode to the Custom Controls in Microsoft InfoPath (1)

= Inthe Task Pane click on Controls ©.

= Then click on Add or Remove Custom Controls... at the bottom of the updated pane view
(see 0). A dialog will appear. This dialog shows a list of installed custom controls.

= Click the Add... button ® to open the “Add Custom Control Wizard”.

= Locate and select TBarCodel0 in list @, then click Next.
= On the following wizard pages you have to specify the data source type for TBarCode. This
selection determines, how the barcode control can be used in InfoPath later on.
For more information, please see below.
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i Fle Edit Mew Insert Format  Tools  Table  Help

C U8 30| wpeim s | @ [

ligﬁﬂ|ﬁﬁreviewForm|dQ?| ¥ B3 @ F
P A4 verdana -0 - | B 7 g|§§

- A

IﬁDra@ Table |_‘]) Mo border

- v_/v|\/:v|1n§ert'JjA|j!

Cuskon conkrals:

Select an ActiveX Control

the Controls task pane,

Select a control:

add...

Remove

Rename. ..

‘¥ou can select an ActiveX contral that is installed on vour computer and make it available in

WG Dacurment

SysColarChrl class
System Information
Tabular Data Control
Tasksymbol Class
TBarCoded
TEarCoded
BarCode?
TConneckorz

Servi

Descy

Sybase Web DataWindow DTC 10.0

TeeChart ChartEditorPanel «5

|

€

Dretails

Yersion: 1.0

'l'"' Language: Language Meutral

= Back.

A
— : Controls * X

Type a question for help =

||]_E] Lavout

'?%" Contrals
5 Data Source
L3 views

Insert controls:

|>

Advanced

&9 Heyperlink,

Aa Expression Box

& Yertical Label

I_H Scrolling Region

IE Choice Group

IE Repeating Choice Group

[ Choice Section

M Repeating Recursive Section

Custom

W

Automatically create data source
Add or Remive Custom Controls...o

(@ Help with Controls

[ ext = l[ Cancel

Figure 11: Add TBarCode to the Custom Controls in Microsoft InfoPath (2)

9.3.1 Specify Data Source Type

In the “Add Custom Control Wizard” you have to decide which kind of data you want to encode:

= If you plan to encode single data fields (e.g. the content of an input box), please follow the

instructions in section 9.3.1.1.

= |f you plan to encode the underlying InfoPath XML document (or parts of the XML docu-
ment), please follow the instructions in section 9.3.1.2.
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9.3.1.1 Encode Single Data Fields

Perform these steps if you plan to encode single data fields:

Add Custom Control Wizand El

Specify a Binding Property
EBind an Actives control property to a field in the Form's data source; this allows data
associated with the control to be saved.
Binding property:
QuietZone -
Ratio
RatioDefault
RatioHint
Readability
RS5_SeqgmPerRow

SizeMode
SuppressErrorMs ®

ot e

Textalignment

TextColor
TextDiskance
TrimSpaces —
Yalue b
[ < Back ” Mext = ] [ Canicel ]

®

Add Custom Control Wizard

Specify Data Type Options
Define a data tvpe for the Activer control,

Field or group bype: |Field {element or attribute) ® w |

Select one or more data types:

hole Mumber (integer)

Decimal {double)

TruejFalse (boolean)

Hypetlink (aryURT) B
Date (dake)

Time (time) v

‘ou can also specify a default data bype to use when adding this
control ko a blank form,

Default data bype: |Text (string) @ L |

[ < Back ” Finish ][ Cancel

Select the binding property
Text (see D).

Click Next.

On the next page (“Specify and
Enable or Disable Property”)
select the entry Enabled.

Click Next.

In @ select “Field (element or
attribute)”.

Then select all data types (by
clicking each single line in ®).
Leave the default data type @
as “Text (string)”.

Then click Finish.

9.3.1.2 Encode Complete or Partial Form Content (XML Data)

Perform these steps if you plan to encode XML data:

Add Custom, Control Wizard El

Specify a Binding Property
Bind an Activel control property to a field in the Form's data source; this allows data
associated with the contral to be saved.

Binding property:

Quality

QuietZone

Ratio

RatioDefault

RatioHint

R55_SegmPerRow

SizeMode

SuppressErrarMsg

Text

Textalignment

TexkColar

TextDistance ®

TrimSpaces —
O

| >

[ < Back ” Mext > ][ Cancel ]
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Select the binding property
Value (see @).

Click Next.

On the next page (“Specify and
Enable or Disable Property”)
select the entry Enabled.

Click Next.
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Add Custom Control Wizard (%) " In @ select “Field or Group

Specify Data Type Dptions (any da.ta type) ”.
Define a data type For the Activel contral, - Then CliCk FlnISh

Field or group type: ([N et N e =N A=)

This control can be bound to a field or group of any data type.

[ < Back ” Finish ][ Cancel

9.3.2  Finish Adding the Custom Control

= After you have completed the wizard, the TBarCode control will be listed in @.
= Click OK (®).
= TBarCodelO appears in the list of available controls (©).

B iDesio emplate Microsoft O o oPath 200 ]

Help Type aquestion for help =
i) (5 | Aprevinrom | QT 4 9B S0 ¢ |8 T @ | Wicesmess.. | @ )
E4_1,\u'erdana - 10 '|BIQ|§_ PR R :_glal’?vév!

ElﬁDraﬂTable |_'f Mo barder - l:l—/ = | S - | dnsert - (05 [ Al J !

i Fle Edit Yiew Insert  Format  Tools  Table

Al -
; — : Controls v X
Add or Remove Custom Controls [x]
- | @ | &
Custom controls:
e
a % Controls
ﬂ_j Data Source
L5 views

Insert controls:

%, Hyperlink,

Aa Expression Box

[IE] wertical Label

@ oK :_E Scrolling Region

IE Choice Group

IE Repeating Choice Graup

|

& Choice Section

Service Problem
— M Repeating Recursive Section
4 | | b’ Custom
Uml TBarCode? g —
Description s/

Automatically create data source

Add ar Remave Custom Contrals. ..

(€) Help with Contrals

Figure 12: Add TBarCode to the Custom Controls in Microsoft InfoPath (3)
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9.4 Insert Barcode

After you added TBarCode OCX to the Custom Controls in Microsoft InfoPath (see section 9.4) you
can add a barcode to your document by performing the following steps:

= Place the cursor where you want to insert the barcode and click on the TBarCode control in
the Task Pane (©).

= Before the barcode is actually inserted a dialog named “TBarCodel0 Binding” appears.

=  Select the required field (Zf) or group (=) as data source (see ®). The content of the
selected entry will be encoded as barcode.

> Please note:
If you have selected single data fields as data source type (see 9.3.1.1) you can select fields
only (no groups!).

= Press OK. A new barcode object will be inserted.

i Fle Edit Wiew Insert  Format  Tools  Table  Help Type a quastion For help =
i) G5 e | By PreviewForn | S (A 9 b 2 B F 9 o8 [ [E | b DesignTasks... | @'_!

4_4 Verdana -0 - | B I g|=E = '
} %] Draw Table [ Noborder - l:l—/ olsa | nsert 2 AR O | a

2 i Controls - x
Service Request ®|1®| A

IE] Layaut
'?%? Contrals

TIBarCode7 Binding (%] 13 Data Source
L5 views

Request Mumber:

Data source:

Contact Informa

Requested By: | | Insert controls:

singleMame {Controllf To set the binding, select a figld or group in which to store the control's data: g) Hyperlink G
= [ = serviceRequest .
Phone Mumber: [ rumber 2 A« Expression Box
[£B datedssigned W vertical Label
E-rnail Address: |=F assignedTo [ " X
=8 dateCpened __EI Scrolling Region
|5 openedBy IE Choice Group

=B dateClosed
| = closedBy
| =7 issue A Choice Section

4 signatures
9 sig e H Repeating Recursive Section

- Custom
Iml TBarCode? o 2

E Repeating Choice Graup

Service

Description

OF l [ Cancel Add or Remaove Custom Contrals. ..

(@) Help with Controls

Figure 13: Insert TBarCode in a Microsoft InfoPath Document
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9.5 Change Binding

of TBarCode (see Figure 13, @), right-click on the bar-

@ Wore Details...

‘e Change Binding... [+, |

Jus ropert T3] show Data Source... The “TBarCodel0 Binding” dialog appears.
Cuntact Infurmatmn n
& Cut
Requested By: I Bt
=3 Copy

Select a field (or group) from the tree view and confirm

Phone Humber: i3y Eoste with OK.
5& | Borders and shading. ..

E-rnail Address: Change To »

TBarCode? Properties. ..

9.6 Adjust Barcode Parameters

The barcode parameters can be adjusted using the Property Pages (a Property List is not ava
able). Please open the property pages as follows:

= Right-click on the barcode object @.
= Select TBarCodel0O Properties... from the pop-up menu (8).
=  The property pages ® will appear.

‘ H H number(CUntrU\ tores dupicate dai) [0] To change the binding which was specified upon insertion
1 TRTINT I (11—

code and select Change Binding... from the pop-up menu.

» For detailed information about the property pages and about the available settings, please
refer to chapter 10.

(Design) Template1 - Microsoft Office InfoPath 2003 | |
! Fle Edt Miew Insert Format Tools  Table Help Type a question for help |+

) (5 [ | By previenFom | (A | £ S (B

P Bz v [E] = =
i 7 Draw Table [ Mo border 'I:l'/ » | & - | msert ~ 5 [ ;‘ﬁ| 7 !

A : Controls - x
Service Request @1®|h

I|I|I|
[

Request Number: ° Bl TBarCode? Properties 3]

Data | Barcode |.¢\ppearance Multiple Barcodes || Schriftart | Farbe | Display || Size Advanced
nurnber (Control stores duplicate data) | @
P T
@ More Details... Barcode type [spmbology): |E0de1 28 ﬂ 4
@ changs Binding. .. Barcode data: Adiust Properties
adjust |

T3 Show Data Source...
Cuntact Informa oc
Requested By: * Qg fficd

=3 Copy Advanced settings
Phone Murmber: [ Paste bacd Farmat/Subset: | v Default

5% Borders and Shading... Check dight [Defaut ~|
E-rmail Addrezs: -

Change To » Compression: |N0ne j
|—e TBarCode7 Properties. . hl [~ Suppress emor messages 9
I™ Translate escape sequences
Service Proh License. . | Abaut... |
]
QK 1 [ Cancel ] [ Apply ]

Description v

Figure 14: Adjust Barcode Properties in Microsoft InfoPath
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9.7 Multiple Barcodes

The feature “Multiple Barcodes” (which is available since TBarCode OCX 7.0) was designed espe-
cially for Microsoft InfoPath. It allows you to encode the contents of an InfoPath form into multiple
barcodes. Therefore the control becomes suitable even for large amounts of data!

Preview’ - Microsoft Office InfoPath 2003 CFEE
! Flle Edit View Insert Format  Tools  Table  Help Type a question for help =
7 | B ciesepreview | (3 VP % a8 9 @ Jl-él.ﬁl'@!
P i Bz p[Sl= === s =R AL
.Y

Service Request

Request Humber: Crate:

0012095008 27.09.2006

Contact Information Location

Requested By: Office Location:

John Smith Right Here

Phone Nurmber: Space:

(5551768093 [

E-rnail Address:
John.Doed@mail.net

Service Problem

|Ch0|:|se a service type... V| |Ch0|:|se a problem type... A

Description

W

:J Form template's location: C:\Documents and SettingsistephanagiLocal Settings!Application DatalMicrosoftInfoPathiC

Figure 15: Multiple Barcodes in Microsoft InfoPath

Please, consider the following points when using multiple barcodes in InfoPath:

= Select a suitable barcode type (symbology) and enable the generation of multiple barcodes.
For detailed information on multiple barcode adjustments, please refer to section 10.4.

= For encoding the content of the whole document (XML data) use the settings as described in
section 9.3.1.2.

=  For reducing the amount of data (when encoding the whole document, e.g.) enabling data
“Compression” is recommended (see section 10.2.8).
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10 The Property Pages

10.1 Introduction

The property pages of TBarCode (and all settings which can be adjusted within the property pages)
are described in detail below. See section 6.3.1 about opening the property pages.

10.2 Property Page “Barcode”

The first property page is the “Barcode” tab. It contains basic barcode adjustments like Barcode
Type (Symbology), Barcode Data, etc. For most applications adjusting these settings will be suffi-
cient. Additional parameters can be changed on demand (button “Adjust...”, tabs “Appearance”,
“Multiple Barcodes”, “Font” and “Color”).

TBarCodel0 Properties |25

Barcode lﬂppeamncel Multiple Barcodesl Fort ] Color ]

Basic settings
Barcode type [symbology):  |[E5E 0 2]
Barcode data: Adjust Properties E

[ 17 characters]
Fl b

Advanced zettings

Encoding mode: |l:0nvert to Code Page j
Code page: |Defau|t ﬂ |D
Format/Subset: | [v Default
Check digit: |Defau|t ﬂ
Compression: |None ﬂ
[ Suppress enor messages [ Translate escape sequences
License... | About... |

0K | Cancel | | Help |

Figure 16: Property Page “Barcode”

10.2.1 Barcode Type (Symbology)

Select the barcode type that you want to create. Common linear barcode types are UPC (USA),
EAN (Europe), Code 128, Code 39, 2 of 5 Interleaved. Common 2D barcode types are Data Matrix
and PDF417.

For information on the different barcode types (symbologies), please refer to the Barcode Refe-
rence (see Appendix A).

10.2.2 Button “Adjust...”

The Adjust... button will open a barcode specific properties dialog (for the selected barcode type /
symbology). This button is available for 2D barcodes and for composite symbologies only!

Barcode specific settings are described in sections 10.7 to 10.15.
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10.2.3 Barcode Data

The content of this textbox will be encoded as barcode. Depending on the selected barcode type
you can encode different kinds of data:

= Some barcodes can be used to encode digits only.
= Others allow the usage of digits and a limited number of special characters like “/” or “*”.
= Again, others can be used to encode arbitrary alphanumeric data.

For more information on barcode types and on codeable data, please refer to the Barcode Refe-
rence (see Appendix A). The number of letters that the data currently contains is shown below
Barcode Data.

» If the “Barcode Data” cannot be represented with the selected symbology, a big "X" is drawn
instead of the barcode. Additionally an error code and a short error description are
displayed.

10.2.4 Encoding Mode

The Encoding Mode specifies how the input data should be interpreted.

» Data is always passed as UNICODE stream to TBarCode OCX. As UNICODE characters
always consist of 2 bytes and most of the barcode types are only able to encode one byte
per character, it is not always clear how the input data should be interpreted. So we give you
the possibility to decide yourself.

» Per default the input data is converted to the selected Code Page (see below). If other kinds
of interpretations are needed, you have to change this property.

You have following possibilities:

Value Description

Convert to Code Page Converts the input data to the code page, which is selected in the
property Code Page. (default)

No conversion (Lower bytes only) Considers only the lower bytes of the input characters, the higher
bytes are ignored.

Bytestream (Lower before higher byte) The data is passed as it is. No conversion is done. Both bytes are
considered. The lower byte is passed before the higher byte.

Bytestream Reverse (Higher before lower byte) Consider both bytes but change the order of lower and higher byte.
That means the higher byte is encoded before the lower byte.

As Hexadecimal Characters Converts the input data, which must consist of hexadecimal values,
to binary data. Pairs of hexadecimal values are converted to
according byte values.

Table 1: Compression

10.2.5 Code page
The code page is related to the property Encoding Mode. It is only considered if the encoding mode

is set to Convert to Code Page. You can choose among several pre-defined code pages (e.g. ANSI,
ISO 8559-1 Latin I, UTF-8, Shift-JIS...) or add the ID of a custom code page.

10.2.6 Format/Subset

The format string is used for formatting the utilizable data of the barcode prior to encoding it.

The format string is built upon placeholders, which can be combined with constant data characters
to build the final data string. Certain control characters make it possible to change the Subsets for

Code 128, EAN 128 and UCC 128 or to define the desired start/stop character of CODABAR.

For detailed information on format strings, please refer to the Barcode Reference (see Appendix A).
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10.2.7 Check Digit

Here you can change the calculation method of the check digit. Whether you need a check digit or
not depends on your application and on the selected barcode type.

By default the appropriate check digit is selected automatically (entry “Default”), which means that
the check digit is calculated according to the barcode specification. Any other suitable calculation
method can be selected via the combo box.

Why check digits? In order to guarantee that the barcode data is read properly, a check digit is
inserted (usually) at the end of the utilizable data. A comparison of the barcode content and the
check digit informs the scanning device about the correctness of the scan. It causes the device
to accept or to reject (repeat) the scan. The check digit calculation method is standardized for
certain common barcodes.

» A change of the check digit method is admissible for special applications or for barcodes
with selectable check digit methods only.

» For some barcodes the standard is no check digit. However, using a check digit is recom-
mended (e.g. LOGMARS or Code39). You can use the combo box for enabling check digit
calculation.

10.2.7.1 Check Digit Override

Some barcodes with a predefined number of utilizable data characters (like all EAN, UPC, Postnet
and RSS-14 codes) include a check digit on a fixed position in the barcode data.

Example:

The EAN13 code permits 12 utilizable digits plus 1 check digit at the
last position (©).
If you enter 12 digits as barcode data this last digit (the check digit) will
be calculated and inserted automatically. However, you can also enter
all 13 digits and therefore override the calculated check digit.

o' peeoon" 7ez 103

> Note: If the check digit is supplied within the barcode data, the internal check digit calcula-
tion will be switched off.

» TBarCode does not check the correctness of the check digit supplied by your application.

“Check digit override” was primarily designed for use with article databases, in which the check digit
is already included in the article numbers. However, the check digit override can also be used to
calculate and to provide your own check digits (usually by program code) or to use all possible
digits for utilizable data (in non standard applications).

Under normal circumstances you should not use this feature — we recommend the automatic cal-
culation of check digits by TBarCode.

10.2.8 Compression

To increment the capacity of barcodes you can compress the “Barcode Data”. This means that the
data provided by the user will be compressed before it is encoded as barcode.

The compression is only available for barcodes which allow the encoding of arbitrary binary data
and a variable length of input data. By default the compression is set to “None”.
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Value Description

None The barcode data will not be compressed. It will be stored in the barcode as is (default).
Deflate (RFC 1951) The barcode data will be compressed using the Deflate algorithm.
We recommend using this algorithm if data compression is required.
GZip (RFC 1952) The barcode data will be compressed using the GNU zip algorithm.
ZLib (RFC 1950) The barcode data will be compressed using the ZLib algorithm.

Table 2: Compression

» Note: When reading compressed barcode data, you will have to decompress it in order to
restore the original input data. Decompression can be done through the TBarCode InForm
software decoder (which restores the uncompressed data automatically). — Or you can use
any third party software library for decompression.

10.2.9 Suppress Error Messages

If the barcode data contains invalid characters (e.g. letters for code 2 of 5 Interleaved), or if the
wrong number of input characters is provided, an error message is displayed (instead of the bar-
code).

If “Suppress error message” is enabled, this error message will be suppressed. Only blank space is
displayed instead of any error information.

10.2.10 Translate Escape Sequences
Selects whether escape sequences (like \n) are translated or not (default: no).

The use of escape sequences is useful if you need to encode control characters such as Carriage
Return or FNC1. For encoding binary data (e.g. Data Matrix) this feature may be very useful as well.

For more information on escape sequences, please refer to the Barcode Reference (see Appendix
A).

10.2.11 Button “License...”

Opens the license dialog. For more information on how to license the product, please refer to
chapter 11.

10.2.12 Button “About...”

Opens the about dialog. The About dialog shows the product version and copyright information to
the user.
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10.3 Property Page “Appearance”

TBarCodel0 Properiies X
Barcode Appearance ]Muhiple Earcodes] Font ] Color ]
General
Orientation: (TR ~ | Frint ratio: 125341234 v Default
Back style: | Tranzparent w» | Bar width reduction [%]: 0.00 [+ Default
Bearer bars: | None w | Bearer bar width [1/1000 mm]: [v
Diraw mode: | Default » |  Quiet zone: Adjust...
Tewxt options
[+ Print text [ Above symbol

Alignment | Default | Text distance [1/1000 mm]: [+ Default

Barcode size and module width

Mode: |Default - Fit to bounding rectangle ﬂ Module width [1/1000 mm]:
Fesolution: |3IJEI dpi [Poor print quality) J Custom resolution [dpil: 30000
Decoder: |Hardware decoder J [~ Display emor if barcode is clipped

ok | Cancel | Help |

Figure 17: Property Page “Appearance”

10.3.1 General

10.3.1.1 Orientation

Specifies the orientation of the barcode. Selectable values are 0°, 90°, 180° and 270°. The barcode
is rotated counter-clockwise.

> Please note: Some fonts (for the human readable text) do not support rotation (e.g. some
bitmap fonts). If rotation is required we recommend selecting a TrueType® font.

10.3.1.2 Print Ratio

The print ratio is the relationship between the bar-widths and the space-widths of a barcode.
Another term for print ratio is “bar width ratio” or “bar/space width ratio”.

> By default there is no need to change the print ratio, unless needed for any special appli-
cation. — Please consider: Barcodes may become unreadable when manipulating this value!

The print ratio must be specified in a specific format. This format depends on the number of
different bar- and space-widths used in the selected symbology.

Example: If a barcode element has 4 different bar widths and 4 different space widths, the print ratio
looks like this (Code 128): 1:2:3:4:1:2:3:4. In the first part ("1:2:3:4") the width ratio of the bars is
set, in the second part the relation of the spaces is set (in our case, they are the same). The small-
est bar is "1" wide, the next larger is "2" wide (thus twice as wide as the smaller bar) and so on.

For more information on print ratios, please refer to the Barcode Reference (see Appendix A).
10.3.1.3 Back Style

The barcode can be painted with transparent background (default, background shines through) or
with opaque background (background is drawn in the adjusted color).
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» If the back style is set to “Transparent”, the adjusted background-color will be ignored.

10.3.1.4 Bar Width Reduction [%]

Sets the bar width reduction in percent.

When printing on inkjet printers, the ink that is absorbed by the paper tends to diffuse. Setting the
bar width reduction allows you to work against this spreading of ink. But also for laser printers with
high toner saturation this property is useful.

The bar width reduction can be specified in percent of the module width. Thus when set to 20 all
bars will be narrowed by 20 percent of the module width.

> Be careful: Setting the bar width reduction to more than 50 percent might leave the bar code
unreadable! When using this feature we recommend you to do some test-scans to make
sure that the bar code can be scanned correctly. A common value to start with is 15%.

10.3.1.5 Bearer Bars

Usually, bearer bars are used with the ITF-14 (or sometimes with the Interleaved 2 of 5) or the DPD
symbology only. The bearer bars were introduced to equalize the pressure exerted by the printing
plate over the entire surface of soft materials. They also enhance the reading reliability by helping to
reduce the probability of misreads by skewed scanning beams.

For some types (like UPC and EAN) the bearer bars must be set to “None”,

Value Description

None Do not print bearer bars.

Top and Bottom Print bearer bars at the top and the bottom of the symbol.
Rectangle Print bearer bars on all 4 sides of the symbol.

For rectangular bearer bars, the quiet zone (see section 10.3.1.7) must be at least 12
times the module width. Otherwise no bearer bars will be printed.

Top Print bearer bars at the top of the symbol.
Bottom Print bearer bars at the bottom of the symbol.

Table 3: Bearer Bars

10.3.1.6 Bearer Bar Width [1/1000 mm]

Sets the width of the bearer bars in 1/1000 mm.

» The minimum width of the bearer bars is two times the module width (which is also used as
default value). If any smaller value is entered, the minimum width will be used instead.

Note: If the bearer bar width is set to zero, no bearer bars are printed.

10.3.1.7 Draw Mode

Due to problems with certain printer drivers, TBarCode is able to use different methods to draw bar-
codes. You can choose between following modes:

Value Description

Default The bar codes are drawn in the advanced mode. This provides the best quality.
Advanced

Compatible The bar codes are drawn in the compatible mode. This decreases the quality slightly,

but is supported by the most printers.

Dual The bar codes are drawn in the dual mode. This is a combination of the Advanced and
Compatible mode.

Table 4: Draw Mode
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If you want to use the “Compatible” draw mode as preferred setting you can specify this in an ini-
file. For more information, please refer to Appendix B.

10.3.1.8 Quiet Zone

The quiet zone is an empty area outside the barcode. It helps the scanner to read the barcode
correctly. Clicking the Adjust... button opens the following dialog:

Quiet Zone X
General
Unit: |mm ﬂ
Left: [10
Right: 10
Top: |D
Bottom: |D
0K | Cancel |

Figure 18: Quiet Zone Adjustment

In this dialog you adjust the quiet zone for all four sides of the barcode. Possible units are: Modules,
Millimeters, Mils and Pixels. Default: No quiet zone is added.

For most 1D barcodes a quiet zone should be maintained directly before and after the barcode
symbol. As a rule of thumb, the quiet zone should be ten times the dimension of the module width
or at least 1/4 inch (6.5 mm). The exact value depends on the selected barcode type.

> Please note: A few barcode types provide the required quiet zone automatically. These bar-
codes are: EAN-8, EAN-13, UPC-A, UPC-E and ISBN. Changing the quiet zone for these
symbologies will add an additional white space.

10.3.2 Text Options

The text options allow the adjustment of the human readable text. The human readable text is
usually printed below the barcode symbol and shows the content of the barcode.

» Not all barcode specifications support the printing of human readable text. If human readable
text is not supported, the following setting will be ignored.

10.3.2.1 Print Text

Specifies whether the barcode data is printed as human readable text or not. Default: Yes.

10.3.2.2 Above Symbol

Prints the human readable text above the symbol (default: below).

» For some barcodes, like UPC and EAN, the adjustment “Above symbol”is not permitted.

10.3.2.3 Alignment

Changes the alignment of the human readable text.

Value Description

Default Uses the default text alignment (= “Center”).
Left Aligns the human readable text to the left.
Right Aligns the human readable text to the right.
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Center Centers the human readable text.

Table 5: Text Alignment
10.3.2.4 Text Distance

Allows you to specify the distance between the human readable text and the barcode (in 1/1000
mm). If "Default" is marked, the minimum text distance is used. Otherwise the given value will be
added.

10.3.3 Barcode Size and Module Width

10.3.3.1 Mode
This option selects the calculation method for the barcode size.

Value Description

Default - Fit to bounding rectangle | Draws the biggest possible barcode which fits into the bounding rectangle. Resizing
the bounding rectangle directly resizes the barcode.

Custom - Specify module width Uses the specified module width for drawing the barcode (see section 10.3.3.2).

Minimal - Optimize for readability Creates the smallest possible barcode for the selected “Resolution” (see section
10.3.3.3) and for the selected “Decoder” type (see section 10.3.3.5).
Furthermore the module width of the barcode will be optimized for ensuring best
readability.

Table 6: Size Mode

> Please note: The size modes “Custom” and “Minimal” influence the horizontal(!) size of a
barcode only! The barcode height is always given by the height of its bounding rectangle.
Only a few 2D barcodes, like Data Matrix, QR-Code or Composite symbologies require a
fixed width to height ratio. For these barcodes the height will be calculated accordingly.

10.3.3.2 Module Width [1/2000 mm]

If the size mode is set to “Custom — Specify module width”, this input box lets you specify the size of
one module (in 1/21000 mm).

A module is the smallest element of a barcode. The widths of all bars and spaces are multiples
of one module width.

Sometimes the “Module Width” is also called “Narrow Bar Width”.

A constant module width is recommended if you have a varying amount of input data and if the
optical data density should remain constant. Furthermore, some label specifications require a cons-
tant module width.

> Please note: When specifying a custom module width the barcode may grow bigger than the
bounding rectangle for big module widths or for a large amount of input data. Please make
sure that the bounding rectangle is wide enough to display the whole barcode symbol.
To ensure that no regions of the barcode are clipped, you can enable the option “Display
error if barcode is clipped” (see section 10.3.4).

10.3.3.3 Resolution

The size mode “Minimal - Optimize for readability” requires the “Resolution” of the printer/scanner to
be selected: As value select the lowest resolution, which is used within the chain of barcode
processing (printing, scanning). Additionally you have to select the decoding solution from the
“Decoder” combo box below. So it can be guaranteed that the printed barcode will be readable for
the selected configuration.
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Examples:

= [f the barcode is printed with 600 dpi and then scanned with a hardware scanner, the
resolution should be set to “600 dpi (Good print quality)”. As decoder select “Hardware”.

= |f the barcode is printed with 600 dpi, transmitted with a fax device (200 dpi) and then
scanned with a hardware scanner, the resolution should be set to “200 dpi (Fax)”. As
decoder select “Hardware”.

= |f the barcode is printed with a laser printer (600 dpi) and if it is then scanned with a flat bed
scanner (150 dpi) and then decoded via software you should select a custom resolution of
“150 dpi”. As “decoder” select “Software”,

Value Description

96 dpi (Screen) Specifies the default screen resolution.

200 dpi (Fax) Specifies the default fax resolution.

202 dpi (Thermo transfer) This resolution is used by thermo transfer printers (e.g. by Zebra® printers).
300 dpi (Poor print quality) Specifies a low printer resolution.

600 dpi (Good print quality) Specifies the standard printer resolution.

Custom dpi Specifies any other resolution.

The dpi value can be entered in the input box on the right (see section 10.3.3.4).

Table 7: Resolution

10.3.3.4 Custom Resolution (DPI)

Specifies the custom dpi value for the size mode “Minimal - Optimize for readability” if Resolution is
set to “Custom dpi”.

10.3.3.5 Decoder

Specifies, which kind of decoder is used for reading the barcode content (size mode “Minimal -
Optimize for readability”).

Value Description

Both Hardware and Software Select this option if you do not know which type of barcode decoder will be used.

Based on the adjusted resolution (see section 10.3.3.4), TBarCode OCX will automati-
cally choose a barcode size which can be read with both decoder types, Software and
Hardware.

» If you are unsure about the resolution, we recommend a setting of 200 dpi (?). This
should be readable in most cases.
Hardware Select this option if the barcode is scanned (and decoded) via a scanning device (e.g.
handheld scanner).
This setting guarantees a minimal module width of 0.254 mm for linear barcodes and
0.5 mm for 2D barcodes. These values are recommended for most hardware scanners.
Software Select this option if the barcode symbol is received as an image (e.g. via flat bed
scanner, camera, fax software, etc.) and decoded via software solution.
This setting guarantees a minimal module width of 5 pixels. This value ensures reada-
bility by most software decoders.

TBarCode InForm Select this option if you plan to use the (upcoming) TBarCode software solution for
decoding the barcode symbol.

Table 8: Decoder
10.3.4 Display Error if Barcode is clipped

For certain configurations, it is possible that the barcode grows bigger than the bounding rectangle.
In this case all bars which extend the size of the bounding rectangle are clipped by default.

To make sure that the barcode does not remain unreadable (because of clipped regions), you can
check the option “Display error if barcode is clipped”. If this property is set, and if the barcode
extends the size of the bounding rectangle, no barcode will be drawn at all. Instead an error is dis-
played.
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This option may help you to avoid truncated barcodes; incorrect printouts can be detected immedi-
ately.
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10.4 Property Page “Multiple Barcodes”

TBarCodell Properties ]

Barcode ] Appearance  Multiple Barcodes l Fort ] Color ]
Multiple barcodes

[ Enable multiple barcodes

Mumber of barcodes [rata limit per barcode [bytes]

Rows: [ D ata limit: I— [v
Colurnre: [v Structured append
Min, barcode distance [1/1000 mm]— | Meder |Standard ]

Horizonkat: v Diynamic: bounding rectangle
Yertical [¥ Mode: D't graw
Description

. If the options on this page are enabled, multipls barcodes are generated as required.

- Thiz iz uzeful to encode large amounts of data. The data iz automahically split and

™ encoded in a sequence of barcodes. This mode should only be wsed with 20
barcodes like Aztec Code, Data Matix. PDF417, QR Code, etc.

#

QK | Cancel Help

Figure 19: Property Page “Multiple Barcodes”

10.4.1 Enable Multiple Barcodes
This option enables the generation of multiple barcodes.

Multiple barcodes can be used for encoding large quantities of data. The data will be split up and
encoded into multiple barcode symbols automatically.

Multiple barcodes are supported for the following symbologies:

= Aztec Code
= Data Matrix
=  MicroPDF417

= PDF417
= PDF417 Truncated
= QR-Code

10.4.2 Number of Barcodes
Specifies the number of barcodes to be created (rows and columns).

Basically, the partitioning of the input data depends on various factors: amount of data, selected
symbology, size of the bounding rectangle, size mode, etc. TBarCode always tries to pack as much
data as possible into one symbol. As a consequence the number of resulting barcodes will be
minimized.

Multiple symbols will only be created...

= if the horizontal or vertical size of one barcode symbol exceeds the size of the bounding
rectangle or of one row/column (see below).

= if the data limit of one barcode is reached (barcode specification or manual limitation, see
section 10.4.4).

Specifying the number of rows/columns internally divides the bounding rectangle evenly into multi-
ple “cells”, which are reserved for one barcode each.
The dimensions of one cell are calculated based on the given number of rows/columns and on the
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"Minimum barcode distance” (see section 10.4.3). With an increasing amount of input data an
increasing number of cells is filled with barcode symbols.

Value

Cols="Auto”
Rows="Auto”

Cols=X
Rows=Y

Cols=X
Rows="Auto”

Cols="Auto”
Rows=Y

Table 9: Number of Barcodes

Description

Tries to use the available space (bounding rectangle) as good as possible.

(Little amount of barcode symbols with lots of data each.)

Divides the bounding rectangle into X*Y cells.

Depending on the amount of input data one or more cells are populated with barcode
symbols. The number of barcode symboals is restricted to X*Y.

Divides the bounding rectangle into X columns.

The number of columns is fixed (X). The number of rows may vary, but is limited by the
height of the bounding rectangle.

Divides the bounding rectangle into Y rows.

The number of rows is fixed (Y). The number of columns may vary, but is limited by the
width of the bounding rectangle.

10.4.3 Minimum Barcode Distance [1/1000 mm)]

This option lets you specify the minimum (horizontal and vertical) distance between the single
barcode symbols. If “Default” is selected, TBarCode will set this value automatically.

10.4.4 Data Limit per Barcode [Bytes]

By default, the largest possible amount of data is encoded per barcode. This amount is limited by
the barcode specification and by the available space (bounding rectangle) only. Un-checking the
“Default” checkbox you can limit the barcode data to a given number of bytes. As a consequence
the data encoded in one single symbol will never grow bigger than specified.

This can be helpful for barcode scanners which have difficulties with very large barcodes.

10.4.5 Structured Append

If structured append is enabled, some additional header information (total humber of barcodes,
index, ...) will be included in each of the barcodes. This information is used for identifying the
correct order, when re-joining the split-up input data.

Value

None

Standard

TBarCode InForm

Table 10: Structured Append

Description

Disables structured append (= no additional header information will be added).
If the barcodes are scanned in the wrong order, the original data cannot be restored
correctly.

Uses the standard structured append method of the selected barcode type.
This mode allows barcode scanners to append the data of multiple barcodes correctly,
even if they are scanned in the wrong order.

Note: Not all barcodes have a standard (native) structured append mode.

Uses a custom structured append method: The header information is prepended to the
“normal” barcode data.

This method can be used if the selected barcode type or the decoder does not support
standard structured append. For decoding TBarCode InForm or a custom software
solution is required.
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10.4.6 Dynamic Bounding Rectangle

Specifies the behavior of the bounding rectangle.

By default the bounding rectangle limits the space which is available for drawing barcodes (“Don’t
grow”). This means, if a barcode (or the sum of all barcodes) grows bigger than the bounding
rectangle, an error message will be displayed.

By changing the value to “Grow horizontally” or to “Grow vertically” you can allow the bounding
rectangle to grow dynamically with increasing amount of input data. This may be useful if the
amount of input data can vary, and if the space which is reserved for barcodes is not limited.

» The features “Grow horizontally” and “Grow vertically” were originally implemented for Micro-
soft InfoPath. Other applications (e.g. Microsoft Access) do not necessarily support these

features!
Value Description
Don’t grow The size of the bounding rectangle is fixed (Default).
Grow horizontally The bounding rectangle can grow horizontally.
If the required space for the barcodes exceeds the size of the bounding rectangle, it will
grow horizontally.
Grow vertically The bounding rectangle can grow vertically.

If the required space for the barcodes exceeds the size of the bounding rectangle, it will
grow vertically.

Table 11: Dynamic Bounding Rectangle
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10.5 Property Page “Font”

In this menu you can adjust the font for the “human readable text”.

TBarCodel0 Properties

X

Barcode ] ﬂppeamnce] Multiple Barcodes  Font ]Color ]

Properhies: Font: Size:
Times Mew Foman| 12 -
Effects
[~ Bold [ Underine
[ ltalic [ Strikeout
Sample Text:

Times New Roman

QK | Cancel Apply

Figure 20: Property Page “Font”
10.5.1 Properties
The entry “Font” is pre-selected.

10.5.2 Font

Selects the font type. The combo box lists all fonts which are available under your operating

system.

> Please consider that some fonts can’t be rotated. Therefore, if rotation is required we

recommend selecting a TrueType® font.

10.5.3 Size
Specifies the font size in points.

10.5.4 Effects

Applies additional text effects. Please, check the corresponding option to create bold, italic, under-

lined and/or stroked-out text.

10.5.5 Sample Text

Shows a preview of the selected font.
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10.6 Property Page “Color”

The colors of the barcode, of the human readable text and of the background can be set here.

TBarCodel0 Properties (|

Barcode] Pappealance] Multiple Barcodes | Font Color l

Broperties: Color Set:
|Standard Calors j
Colar Palette:
B | ForeColor i
o~
B | TestColor

+

Edit Custom Color. . |

Figure 21: Property Page “Color”

In order to change the color for one of the barcode components (background, foreground, human
readable text), you have to select the corresponding property in @ first. Then click on the desired
color in ®.

» Please note: The color in ® will only be updated when switching between the list entries.

10.6.1 Properties
Select the property that you want to change:

= BackColor
The background color of the barcode (color of the spaces). If the back style is set to
“Transparent”, the adjusted background-color will be ignored.
= ForeColor
The foreground color of the barcode (color of the bars).
= TextColor
The color of the human readable text.

10.6.2 Color Set

You can choose between “Standard Colors” and “Windows System Colors”. Each of these color
sets offers a different color palette.

10.6.3 Color Palette
Clicking on one of the list entries assigns the color to the selected property.
10.6.4 Edit Custom Color...

Clicking this button opens a dialog which lets you select a color for the list entry <Custom...>.
Alternatively you can also double-click on the <Custom...> list entry.
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10.7 Adjust...

Depending on the selected barcode type TBarCode offers additional barcode specific adjustments.
You can access these adjustments by clicking on the Adjust... button in the “Barcode” tab. This
button is available for Aztec Code, Codablock-F, Data Matrix, MaxiCode, MicroPDF417, PDF417,
PDF417 Truncated, QR-Code, Micro QR-Code and all Composite Symbologies.

TBarCodel0 Properties ()]

Barcode ]Appealance] Muttiple: Barcodes | Fort | Color |

B azic settings
Barcode type [syrbology]:

B arcode data: Adjuzt Properties -

[ 17 characters)
P p

Advanced settings

Encoding mode: |I:omrert to Code Page j
Code page: |Defau|l ﬂ |Ij
Farmat/Subset: | [v Default
Check digit | Defaul |
Compression: | MHone j
[ Suppress ermor messages [ Tranzlate escape sequences
Licenze. . | About... |

QK Cancel Help
| | |

Figure 22: Adjust...

The following sections 10.8 to 10.15 will give an overview over barcode specific properties.

> Please take care when modifying these properties. Some settings may result in unreadable
barcodes. Always make a test scan in case of doubt!
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10.8 Adjust Properties: Aztec Code

Aztec Code is a 2-dimensional Matrix Code. Characteristic for the Aztec Code is the finder in the
center of the symbol which contains of 3 to 5 lapping squares.

Aztec Code Properties X
General
Farmat / farmat specifier: ~| [ [2digis 1 chal
Symbal zize: |Default ﬂ
Enforce binary encoding; l_
Enable Aztec Runes: -
Error comection in % [0-90] | [v Default

Structured append
Usge structured append: l_

MHurnber of spmbols [4.Z]: |A
Index of this symbal [5.Z) |2

Message I [optional): |

1]8 | Cancel

Figure 23: Advanced Properties: Aztec Code

10.8.1 Format/Format Specifier

You can choose from:

Value Description

Default The standard format of Aztec Code.

UCC/EAN Special format defined by UCC and EAN. Used for encoding so-called Application Identifiers.
FNC1 is added at first position.

Industry For special industry formats. If you choose this value, you have to fill in a Format Specifier (2

digits or 1 letter). It determines which industry format the barcode data corresponds to.
FNC1 is inserted at second position.

10.8.2 Symbol Size

Defines the size of the Aztec Code symbol. Possible values range from “(1) 15 x 15" to “(33) 151 x
151" modules. If the property is set to default, the size is computed automatically based on the
length of the barcode data.

Additionally you can select one of three reader mode: 19x19 reader, 23x23 reader, 27x27 reader.
These modes are often used to program the barcode scanners.

10.8.3 Enforce binary encoding

If checked binary mode is used for encoding (no input data analysis). This mode is recommended if
you want to encode binary input data.

10.8.4 Enable Aztec Runes

The Aztec Runes mode is a special mode of the Aztec Code. You can encode only values between
0 and 255. Aztec Runes can be displayed in a very compact way and are highly readable due to
Reed Solomon error correction.
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10.8.5 Error Correction in % [0-90]

Unlike other barcode types the error correction level of an Aztec Code is not described in pre-
defined levels but can be specified in percent of the data amount. Default error correction level is
23% (which is recommended), but it may be in the range from 0 up to 90%.

10.8.6 Structured Append

If you want to “connect” several Data Matrix symbols in order to encode larger quantities of data,
you can use “Structured Append".

10.8.6.1 Use structured append
Activates structured append (symbol-chaining) with this option.

10.8.6.2 Number of all symboils [A...Z]

Enter the total number of chained Data Matrix symbols here. A maximum of 26 symbols may be
used within one chain, where “A” stands for 1 and “Z” stands for 26.

10.8.6.3 Index of this symbol [1...16]
A symbol identification number — which is entered in the index field — must be assigned to each

Data Matrix symbol. Its value can range from “A” (1) to “Z” (26). This index indicates the order in
which the data is joined after the reading/scanning process.

10.8.6.4 Message ID

The Message ID has to be the same for all symbols within a chain.
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10.9 Adjust Properties: Codablock-F

Codablock-F is a stacked symbology (like PDF417) based upon the Code 128 character set. Each
row consists of a Code 128 symbol, but extended with row indicators (row count and sequence
number) and an additional check digit.

CODABLOCK-F Properties e
Frows [2.44] | ¥ Default
Columns [4..62]: | [+ Default
R height [1/1000 mm]: | [v Default
Separator height [1/1000 mm]; | [+ Default

Code format: |Defau|t ﬂ

Figure 24: Advanced Properties: Codablock-F
10.9.1 Rows [2..44]

Specifies the number of rows used for encoding. The value must be between 2 and 44. Default: the
number of lines is calculated automatically depending on the number of input characters.

10.9.2 Columns [4..62]

Defines the number of columns of the generated bar code. The value must be between 4 and 62.
Start-, stop- and line-indicator columns, as well as code subset selectors are not taken into account.
Default: the number of columns is calculated automatically depending on the number of input
characters.

10.9.3 Row height [1/2000 mm)]

Sets the height of an individual row in 1/1000 mm. Default: The row height is calculated automati-
cally.

10.9.4 Separator height [1/1000 mm]

Sets the height of the row separator in 1/1000 mm. Default: The height of the separator is calcu-
lated automatically.

10.9.5 Code format

You can choose one of the following formats:

Value Description
Default Standard format.
UCC/EAN Special format defined by UCC and EAN to be used in UCC/EAN applications. Used for encoding

so-called Application Identifiers (Als). A FNCL1 is encoded at first position automatically.
Table 12: Codablock-F Code Formats
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10.10 Adjust Properties: Data Matrix

» Please note: TBarCode always encodes data using the newest ECC200 error correction
method.

In this dialog you can set Data Matrix specific properties.

Data Matrix Properties ]
Code format: h
Symbal size: | Drefault j
Enfarce binary encoding: B
Show as rectangle: [

Stuctured append
Uze structured append: B

Mumber of all symbols [2..16]: |2

Index of this symbol [1.16 |1
File 1D [1..64516} [i

QK. | Cancel

Figure 25: Advanced Properties: Data Matrix

10.10.1 Code Format

Sets the code format which is used for encoding the barcode data.

Value Description

Default The standard format of Data Matrix (no special header included).

UCC/EAN Special format defined by UCC and EAN for encoding Application Identifiers. This format adds the
function character FNC1 at 1st position in the symbol.

Industry This setting supports peculiar industry formats. It adds FNC1 at 2nd position.

Macro 05 [)>Rs05Gs is encoded at the beginning of the code.

Macro 06 [)>Rs06Gs is encoded at the beginning of the code.

Reader This setting activates the reader programming mode.

Programming

DP Postmatrix Spdecial format defined by “Deutsche Post”. A special finder pattern is drawn on the left side of the bar
code.

Table 13: Data Matrix Code Formats

10.10.2 Symbol Size

Defines the size of the symbol in terms of rows and columns. Possible sizes are "10 x 10" to "144 x
144" modules for a square symbol and "8 x 18" to "16 x 48" for a rectangular symbol. When set to
default the minimal square size is used (depending on input data).

10.10.3 Show as Rectangle

Determines if the Data Matrix symbol should be displayed as rectangle (checked) or square
(unchecked — default).

10.10.4 Structured Append

If you want to “connect” several Data Matrix symbols in order to encode larger quantities of data,
you can use “Structured Append".
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10.10.4.1 Use structured append

Activates structured append (symbol-chaining) with this option.

10.10.4.2 Number of all symbols [2...16]

Enter the total number of chained Data Matrix symbols here. A maximum of 16 symbols may be
used within one chain.

10.10.4.3 Index of this symbol [1...16]

A symbol identification number — which is entered in the index field — must be assigned to each
Data Matrix symbol. Its value can range from 1 to 16. This index indicates the order in which the
data is joined after the reading/scanning process.

10.10.4.4 File-ID [1...64516]

The File ID has to be the same for all symbols within a chain.
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10.11 Adjust Properties: MaxiCode

MaxiCode represents data by drawing hexagonal items which are arranged around a circular center
(bull's eye). The internal data structure is regulated by different modes. The "Structured Carrier
Message" mode was defined by the United Parcel Service UPS®. Data can be encoded with two
different error correction levels: SEC (= Standard Error Correction) and EEC (= Enhanced Error
Correction).

MaxiCode is very flexible. With structured append you can divide larger quantities of data into seve-
ral MaxiCode symbols (see also section 10.4, Property Page “Multiple Barcodes”) — they are then
re-joined by the scanner.

The maximum data capacity of one symbol is 93 characters. The actual quantity of the utilizable
data depends on the selected mode, the number of special characters, and whether numeric
sequences are used or not (numeric sequences can be encoded using less space than ASCII data).
Last but not least the error correction level influences data capacity.

MaxiCode Properties |28
Mode: .
Undercut [0,.100 %] [ [¥ Default
Preamble optionz
Uze preamble ™ Preamble date [0..99]; |96
Structured append Structured camier message [SCH);
Usze shructured append: r Service clags [0.999]:

Mumber of all symbals [2..8]: |2 Country code [0.999]:

Index of this sprmbal (18] |4 Pastal code [9 digits]:
Ok | Cancel |

Figure 26: Advanced Properties: MaxiCode

10.11.1 Mode

Selects the mode for the actual symbol. Default: Mode 4.

Value Description

Default Is equal to Mode 4

Mode 2 SCM Numeric » Structured Carrier Message with 9 digits Postal Code (digits only)

Mode 3 SCM Alphanumeric » Structured Carrier Message with up to 6 characters Postal Code (alphanumeric
characters)

Mode 4 No SCM, encoding of numeric and alphanumeric characters (incl. Standard Error Correction)

Mode 5 Full EEC - like mode 4 but with maximum error correction (safer, but less data possible)

Table 14: MaxiCode Compaction Modes
10.11.2 Undercut [0..100 %]

The undercut influences the diameter of the hexagonal barcode elements. In new applications it is
recommended (according to the AIM standard) to use an undercut setting of 75% (default).

10.11.3 Preamble Options

Used in particular open system standards. Under “Preamble date” the last two digits of a year can
be entered. They are automatically inserted into the data stream in a predefined place.

The preamble can also be specified by escape sequences in the “Barcode data” (alias Text proper-
ty). To learn more about this option please refer to the Barcode Reference (see Appendix A).
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10.11.3.1 Use Preamble

Enables the preamble mode if checked.

10.11.3.2 Preamble date (0...99)

This is the value of the preamble year to be encoded in the MaxiCode symbol.

10.11.4 Structured Append

Structured append is used for appending multiple MaxiCode symbols to one chain. Therefore some
ggligglr.\al header information (total number of barcodes, index) will be included in the barcode

Using structured append, a large amount of input data which is split up into multiple barcode sym-
bols can be re-joined correctly, even if the barcodes are read in the wrong order.

10.11.4.1 Use structured append

Activate this option if structured append should be activated.
10.11.4.2 Number of all symbols [2...8]

The total number of MaxiCode symbols must be specified in this field.
10.11.4.3 Index of this symbol [1...8]

The symbol identification number (index) can be assigned to each MaxiCode symbol. Its value can
range from 1 to 8. The index is used for identifying the correct re-joining order.

10.11.5 Structured Carrier Message (SCM)

MaxiCode was originally developed by uPSs® (United Parcel Service). The operating modes 2 and 3
(Structured Carrier Message) provide the additional data-fields Service Class, Country Code and
Postal Code.

These fields can also be specified by escape sequences in the “Barcode data” (alias Text property).
For more information, please refer to the Barcode Reference (see Appendix A).

10.11.5.1 Service class [0...999]

Specifies the service class (used with within the SCM - mode 2 or 3).
10.11.5.2 Country code [0...999]

Specifies the country code (used with within the SCM - mode 2 or 3).
10.11.5.3 Postal code [9 digits]

Specifies the postal-code (used with within the SCM - mode 2 or 3).

= Mode 2: up to 9 digits can be specified.
= Mode 3: up to 6 characters (digits and uppercase letters) can be specified.

WWW.TEC-IT.COM Page 55 of 69




10.12 Adjust Properties: PDF417

PDF417 divides data content into graphical rows and columns. It is a so-called “stacked symbolo-
gy”. This property page allows you to change specific settings for PDF417, PDF417 Truncated and
MicroPDF symbologies.

PDFA17 Properties —— (]
FDF417
Rows[3.90) [ ¥ Detauk Rowheight 1A000wmm]: [ [ Defaul
Colurmns [1..30] ’7 [¥ Default  Eror comection level |Default j
Encoding Mode: | Default j
MicroPDF417
Mode: Drefault v | Version: |Default [auto zelect) j

M acro PDFA1T [structured append)
Usze Macro POF417: [~

Segment index -

File I [alphanurneric):

File name:

Segment count [1..99999]:

Time stamp:

Addressees:

File size:

3 JREY JE B IE E e

|
|
|
|
Sender: |
|
|
|

Checksum [CCITT-1E):

%

Cancel

Figure 27: Advanced Properties: PDF417

> Please take care when modifying these properties. Some settings may result in unreadable
barcodes. Always make a test scan in case of doubt!

10.12.1 PDF417

These settings apply for all PDF417 based barcodes (PDF417, PDF417 Truncated, and
MicroPDF417).

10.12.1.1 Rows [3..90]
Specifies the number of rows of one PDF417 symbol. Values between 3 and 90 are allowed.

Default: the number of lines (rows) is calculated automatically depending on the amount of input
data.

10.12.1.2 Row height [1/1000 mm]
Sets the height of an individual row in 1/1000 mm.

Default: the row height is calculated automatically depending on the bounding rectangle and the
number of rows.

Some label specifications require a specific ratio between module width and row height.
Example: If a ratio of 1:3 is required you might set the module width to 254 and the row height to
762.
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10.12.1.3 Columns [1..30]

Defines the number of columns of a PDF417 symbol. Values between 1 and 30 are allowed. The
start-, stop- and line-indicator columns (which are fixed parts of the symbol) are not taken into ac-
count.

Default: the number of columns is calculated automatically depending on the number of input
characters.

» You should not set both rows AND columns to a constant value!

10.12.1.4 Error Correction Level
Sets the error correction level. Values between 0 and 8 are allowed.

The error correction level defines the number of code words which are used for error recognition/
correction. Each PDF417 barcode contains at least two code words:

Level 0: 2 code words. Level 1: 4 code words. Level 2: 8 code words. And so on: Levels 3 to 7 are
using 16, 32, 64, 128 and 256 code words. Level 8 uses 512 code words for error correction.

Value Description

Default Depending on the amount of input data the error correction level is set to a value between 2 and 5
automatically.

0 Error recognition only (no error correction is possible). 2 code words are used for calculating a check sum.
Error correction. 4 code words are used for error correction information.

2 Error correction. 8 code words are used for error correction information.

8 Error correction. 512 code words are used for error correction information.

Table 15: PDF417 Error Correction Levels

A higher error correction level adds more redundant information to the symbol. Therefore the
symbol will require more space for printing. If the symbol is distorted through surface damage,
bad printing quality or dirt the error correction information can help to reconstruct the full infor-
mation contained in the PDF symbol (reconstruction is done by the scanner).

> The error correction algorithm (Reed Solomon) has the following limit for a successful
reconstruction of data: ([total number of not decodable characters] + 2 * [number of read
errors]) must be smaller than ([number of error correcting code words] - 2).

10.12.1.5 Encoding Mode
Choose the encoding mode of the barcode.

Value Description

Normal (Default) Analyzes the input data.

Depending on the input data either “text”, “numeric” or “binary compaction” mode is
used in order to keep the resulting symbol as small as possible.

Binary Compaction Uses binary mode for encoding (no input data analysis). This mode is recommended if
you want to encode binary input data.

10.12.2 MicroPDF417

These settings apply for the MicroPDF417 symbology only.
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10.12.2.1 Mode

Specifies how data is encoded when using Micro PDF417. In most cases the “Default” or the
“Binary” mode is the best choice. Some decoders may not support all modes listed here. — Please,
check with your scanner first.

Value

Normal (Default)

UCC/EAN-128 Emulation

Codel28 Emulation
Codel28 FNC2 Emulation
Linked UCC/EAN-128

05 Macro
06 Macro
CC-A Data Mode
CC-B Data Mode

Description

Analyzes the input data.

Depending on the input data either “text”, “numeric” or “binary compaction” mode is
used in order to keep the resulting symbol as small as possible.

UCC/EAN-128 emulation mode. Transmit ]C1 or ]L3.

Use compaction for Application Identifier (Al) "01" + 14 digits.

Code-128 emulation mode. Transmit ]C2 or ]L4.
Code-128 with FNC2 on first position will be emulated.

Linked UCC/EAN-128 emulation. Transmit ]C1 or JL3.

This mode links the MicroPDF symbol with a linear (1D) symbol. The linked symbol may
be required for a successful scan.

The symbol can be encoded with better compaction when using one of the following
orders for Application Identifiers (Als):

= date (Al 11, 13, 15 or 17) + lot number (Al 10) + other Als (optional).

= date (Al 11, 13, 15 or 17) + serial number (Al 21) + other Als (optional).

= date (Al 11, 13, 15 or 17) + other Als (optional).

Note: This mode is not used with UCC/EAN Composite Symbology, which uses linked
symbols as well.

The preamble [ (> RS 0 5 GS precedes the barcode data.

The preamble [ (> RS 0 6 GS precedes the barcode data.

Uses Base-928 compaction and processes input data as byte array.

Uses binary compaction (Base-900). The barcode data is prefixed with a reserved code
word.

Table 16: Micro PDF417 Compaction Modes

10.12.2.2 Version

Specifies the size of the symbol in terms of codeword columns and MicroPDF417 rows.

10.12.3 Macro PDF417 (structured append)

Macro PDF417 is used for connecting multiple PDF417 symbols (PDF417, PDF417 Truncated or
MicroPDF417) into one chain. For each symbol of the chain you can specify

= the “Segment Index” of the actual symbol
(“Last symbol” specifies, that the actual symbol is the last symbol in the chain),
= the “File ID” (which identifies one chain of symbols),

= optional information:

- File name

- Segment count

- Time stamp
- Sender

- Addressee
- File size

- Checksum (CCITT-16)
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10.13 Adjust Properties: QR-Code / QrR-Code 2005

The QR-Code is a 2-dimensional matrix symbology (like Data Matrix). It has a remarkable data
capacity of up to 3000 ASCII characters or 7000 digits. The QR-Code symbology was designed to
read a lot of data within a minimum of time (QR-Code means Quick Response Code).

QR-Code 2005 is a variant of QR-Code, which supports a default data encoding of Latin-1 instead
of Kanji (Japanese character set) and is commonly used in Europe.

QR-Code Properties (S|
General
Format / application indicator: ’— [2 digitz. 1 char]
Symbol version [zize]: | Drefault ﬂ
Error comection level: |[M]edium ﬂ
Mask pattern: |Default ﬂ
Compaction: | Diefault j

Structured append
Use structured append: ™ Parity byte: |0 [0..255]

Mumber of all symbals [2..16]; |2
Index of this spmbol [1..16]: |'I

oK | Cancel

Figure 28: Advanced Properties: QR-Code

10.13.1 Format / Application Indicator

You can choose from:

Value Description
Default The standard format of QR-Code.
UCC/EAN Special format defined by UCC and EAN. Used for encoding so-called Application Identifiers.

FNC1 is added at first position.

Industry For special industry formats. If you choose this value, you have to fill in an Application Indicator (2
digits or 1 letter). It determines which industry format the barcode data corresponds to.
FNC1 is inserted at second position.

Table 17: QR-Code Formats

10.13.2 Symbol Version (Size)

Defines the version (= size) of the QR-Code symbol. Possible values range from “(1) 21 x 21" to
“(40) 177 x 177" modules. If the property is set to default, the size is computed automatically based

on the length of the barcode data.

10.13.3 Error Correction Level

Defines the error correction level.

Value Description

(L)Yow Lowest level. Data recovery capacity is approximately up to 7%.
(M)edium Up to 15%

(Q)uartil Up to 25%

(H)igh Highest level. Up to 30%

Table 18: QR-Code Error Correction Levels
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10.13.4 Mask Pattern

Selects the mask pattern, which is applied to the barcode symbol (XOR masking). The goal of the
mask pattern is to distribute the bar-space transitions evenly over the symbol in order to improve
the readability of the barcode.

Value Description
Default Selects the mask pattern automatically (recommended).
0.7 Selects one of the mask patterns (0 to 7) manually.

Manual selection may be useful, if you want to generate many symbols within minimal computa-
tion time. The algorithm for identifying the optimal mask automatically is complex (and resource
consuming). However, the readability of the barcode may suffer when using manual selection.

Table 19: QR-Code Mask Patterns

10.13.5 Compaction

QR-Code can compact dedicated Multi Byte character sets from 16 bit representation into 13 bit en-
coding. This property enables the compaction of Kanji or Simplified Chinese characters into 13-bit
values.

ActiveX controls are using the Unicode™ character set. Depending on the Code Page property, the
Unicode input is converted to the corresponding encoding.

If you use one of the available compaction modes, please make sure that the Unicode input is
converted to either Shift JIS X 0208 (Kaniji) or GB2312 (Simplified Chinese). Also make sure that
your decoder (scanner) can deal with these compaction modes.

Value Description

Default Default multi byte character compression. Depends on specified Code Page.

None No multi byte character compression.

Kanji compaction Enables Kanji character compaction. Input data must be supplied in Multi Byte character set Shift

JIS X 0208 (see Code Page). Compaction of Kanji characters is done according to ISO/IEC
18004 (and AIM ITS/97-001) specification.

Chinese compaction | Enables Chinese character compaction. Input data must be supplied in Multi Byte character set
GB2312 (see Code Page). Compaction of Chinese characters is done according to GB/T 18284-
2000). Please note that this compaction mode is not supported by all decoders.

Table 20: QR-Code Compaction Modes

10.13.6 Structured Append

If you want to connect several QR-Code symbols (for encoding larger quantities of data) you can
use structured append.

10.13.6.1 Use Structured Append
Activates structured append (symbol-chaining).
10.13.6.2 Parity Byte [0...255]

Chained QR-Code symbols are identified by the parity byte. The parity byte must be identical in all
symbols of a chain.

» The value of the parity byte depends on the barcode data for the complete chain. To calcu-
late its value you can use the method QRCode.StructAppParity() which is available in the
ActiveX interface.

For more information about the ActiveX interface and its available methods, please refer to
the developer manual (see Appendix A).
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10.13.6.3 Number of all Symbols [2...16]

Enter the total number of chained QR-Code symbols here. A maximum of 16 symbols may be used
within one chain.

10.13.6.4 Index of this Symbol [1...16]

A symbol identification number — which is entered in the index field — must be assigned to each QR-
Code symbol. Its value can range from 1 to 16. This index indicates the order in which the data is

joined after the reading/scanning process.
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10.14 Adjust Properties: Micro QR-Code

The Micro QR-Code is a small variant of the QR-Code with a reduced number of overhead modules
and a restricted range of sizes. The maximum amount of data is 35 numeric, 21 alphanumeric, 15
byte, or 9 Kanji characters (in conjunction with the lowest error correction level).

QR-Code Properties ||
General
Format / application indicatar: | J | [2 digitz, 1 char]
Spmbol version [size): -
Eror comection level: |[M]edium hd
Mask pattern: |Default ﬂ
Cormpaction; |Defaull ﬂ

Structured append

Index of thiz spmbol [1..16]:

Mumber of all symbols [2..16]: |

o Parity byte: [0.255]

|
0K | Cancel

Figure 29: Advanced Properties: Micro QR-Code

10.14.1 Symbol Version (Size)

The Micro QR-Code has four different symbol sizes (M1-M4). The smallest version (=size) M1 is
restricted to numeric data and error detection, M2 may contain alphanumeric values, M3 and M4
may use the whole range of the QR-Code character sets (bytes, Kanji).

10.14.2 Error Correction Level

Defines the error correction level — See QR-Code, section 10.13.3.

10.14.3 Mask Pattern

Sets the mask pattern — See QR-Code, section 10.13.4.
Note: The Micro QR-Code has only 4 mask patterns and not 8 like the QR-Code.

10.14.4 Compaction

Defines the compaction mode — See QR-Code, section 10.13.5.
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10.15 Adjust Properties: Composite/RSS

In this menu you can adjust the parameters for the “EAN.UCC Composite Symbology” and for the

“RSS Expanded Stacked” symbology.

Composite/RSS Properties

|

EAM.UCC Composite Symbology

Compasite companznt: Default [Mone)

|f Composite Symbology is enabled the following rules apply for data encading:

a) If the baze symbology requires a fiked number of input characters [e.g. ASS-14) all
input characters beyond the required amount will be encoded in the composite
companent automatically.

b) If the baze symbology allows a warniable number of input characters the vertical bar
character " must be used to seperate the composite data from the baze data.

RS55 Expanded Stacked

Segments per row:

[v¥ Default

Ok, | Cancel

Figure 30: Advanced Properties: Composite/RSS

10.15.1 Composite Component

Sets the 2D composite component in order to generate an EAN.UCC Composite Symbology.

Value

Default (None)
Auto (CC-A/B/C)
CC-A

CC-B

Cc-C

Description
Composite Symbologies are disabled
Automatically choose CC-A, CC-B or CC-C type depending on the length of the input data

Use composite component A (CC-A).

CC-A is a variant of the MicroPDF417 symbology with a unique combination of row address
patterns (RAP). It is the smallest variant of the 2-dimensional composite component. Up to 56
characters can be coded (also alphanumeric) with 3 to 12 rows and 4 columns.

Use composite component B (CC-B).
CC-B is a subset of the MicroPDF417 Symbol which is identified by the code word 920. CC-B wiill

be chosen automatically when CC-A has not enough capacity (in Auto-mode). CC-B encodes up
to 338 Characters (alphanumeric) in 3 to 12 rows and 2 to 4 columns.

Use composite component C (CC-C).

The CC-C structure is a PDF417 Symbol which is identified by the internal code word 920 (920 is
the first code word after the symbol length indicator). The CC-C structure can be used as a 2D
composite component of a UCC/EAN-128 Composite Symbol. It has the largest data capacity
among the composite symbologies. It encodes numbers and alphanumeric characters with up to
2361 characters length in 3 to 30 rows. It uses up to 30 data error checking code columns.

Table 21: Composite Component Format

» You can add Composite Components to the following symbologies: EAN-8, EAN-13, UPC-E,
UPC-A, RSS family and EAN-128. — CC-C is available for UCC/EAN-128 only!

10.15.1.1 Data Input for the EAN.UCC Composite Symbology

If the composite component is enabled, the data for the 2D composite component has to be

separated from the linear component with a vertical bar

Example: 1234567890123|CompositeData

If a symbology has a fixed data length (such as RSS-14) the vertical bar is optional. All remaining
characters (after the 14" digit) will be encoded into the 2D component automatically.
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10.15.2 Segments per Row

For the RSS Expanded Stacked symbology you can adjust the number of data segments per row.
Allowed are even values between 2 and 22. This parameter influences the width to height ratio of

the barcode symbol.
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11 Licensing

11.1 License Types

Please check out http://www.tec-it.com/order for available license types and pricing.

Single licenses are bound to exactly one machine. If you are interested in a single license, please
tell us the so-called "System ID” of the target computer. You can find the System ID in the licensing
dialog (see below).

11.2 Entering your License Data

After receiving your license data, enter it in the license dialog. You can also pass the license
information via program code (software developers) — see section 8.5.

» Please enter the license data exactly as you received it from TEC-IT!
Spacing and upper/lower case letters are significant. To avoid typographical errors, please
insert the data using “copy and paste” from the email containing your license data whenever
possible.

11.2.1 License Dialog

For entering the license data right-click on the inserted TBarCode object and select TBarCode-
Object » License from the pop-up menu.

The following dialog will appear:

License Informaticn TBarCode 10 =i ©® This is the System ID of your Computer.
Systern-lD: ’m
Fraduct: [TBarCode 2D [incl. 2D symbologies] _+ | Under "Product” select the product that you have
T IDEMO VERGION purchased: You can select:
Kind of icense: [Site [Fimeniizenz) =] = TBarCode 1D (standard)

= TBarCode 2D (incl. 2D symbologies).

Mumber of licenses: |‘I

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

t'our license-key: |

In the field "Licensee” enter the name that you
[0k | Ccocd entered as licensee at _the time of your purchase (or

the name that was assigned to you when you
received the license key).

Under “Kind of License” select the kind of license
that you have purchased. You can select:

= Single (Einzellizenz)
= Site (Firmenlizenz)
= Developer (Entwicklerlizenz).

Under "Number of Licenses” enter the number of li-
censes that you have purchased.

In the field "Your license-key” enter the license key
exactly as you received it from TEC-IT.
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12 Contact and Support Information

TEC-IT Datenverarbeitung GmbH

Address:  Wagnerstr. 6
AT-4400 Steyr
Austria/Europe

Phone: +43/(0)7252/72720
Fax: +43/(0)7252/72720-77
Email: mailto:support@tec-it.com

Web:  http://www.tec-it.com

AlX is a registered trademark of IBM Corporation.

HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C, World Wide Web Consortium, Laboratory for Computer
Science NE43-358, Massachusetts Institute of Technology, 545 Technology Square, Cambridge, MA 02139.

JAVA® is a registered trademark of Sun Microsystems, Inc., 901 San Antonio Road, Palo Alto, CA 94303 USA.

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by
Netscape.

Microsoft®, Windows®, Microsoft Word®, Microsoft Excel® are registered trademarks of Microsoft Corporation.

Navision is a registered trademark of Microsoft Business Solutions ApS in the United States and/or other countries.

Oracle® is a registered trademark of Oracle Corporation.

PCL® is a registered trademark of the Hewlett-Packard Company.

PostScript is a registered trademark of Adobe Systems Inc.

SAP, SAP Logo, R/2, R/3, ABAP, and SAPscript are trademarks or registered trademarks of SAP AG in Germany (and in several other
countries).

Unicode is a trademark of Unicode Inc.

All other products mentioned are trademarks or registered trademarks of their respective companies. If any trademark on our web site or in this
document is not marked as trademark (or registered trademark), we ask you to send us a short message (mailto:office @tec-it.com).
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Appendix A: Related Downloads

A.1 Developer Manuals

For software developers TBarCode provides additional documents:

= Developer Manuals
Descriptions on how to use TBarCode in development environments (IDES) like Microsoft
Visual Studio, Borland Delphi, Borland C++ Builder, Sybase Power Builder, ASP, .NET and
more...

= Developer References
Detailed descriptions of the TBarCode programming interface (API) with all methods,
properties, enumerations and events.

These documents are included in the setup (Start Menu: TEC-IT TBarCode 10 » Developer
Manuals).

A.2 Sample Applications

TEC-IT provides a number of sample applications which allow customers to start with the develop-
ment of their own applications and/or documents as fast as possible.

Sample applications are included in the TBarCodelO setup (Start Menu: TEC-IT TBarCode 10 »
Examples) or can be downloaded from the TEC-IT web site http://www.tec-it.com (download area).

> Make sure TBarCode was installed before trying to run any sample application!

A.3 Barcode Reference

The document “Barcode Reference” provides an overview over supported barcode types and gives
additional information on how to use them.

The following issues are discussed:

=  Supported Barcode Symbologies
(with detailed information on each barcode type)
= Check Digits
(general information and available check digits methods)
= Print Ratio and Ratio Hints (or Ratio Format)
= Format Strings
= Escape Sequences and Control Characters
= Application Identifiers
= MaxiCode and UPS standards
= And more...

The Barcode Reference is available as separate document on the TEC-IT web-site http://www.tec-
it.com » Support » Knowledge Base.

The direct URL is as follows:

http://www.tec-it.com/download/PDF/Barcode Reference EN.pdf.
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Appendix B: TBarCode INI-File

For TBarCode you can specify an ini-file which allows you to do the following tasks:

= Preset the Draw Mode to “Compatible”
= Apply a Site Lock (OCX only)
= License TBarCode

First create a text file named barcode.ini and put the file in the same directory where the TBar-
Code.dll and the TBarCode.ocx are located. This is usually the TBarCode installation directory
C:\Program Files\Common Files\TEC-IT\TBarCode\10.0. Then edit the ini-file.

> Please Note:
The ini-file is loaded together with the TBarCode DLL. All settings which were taken from
the ini-file may later be overridden per program code or via the property pages of every
single TBarCode instance.

B.1 Compatible Draw Mode

In order to use the “Compatible” draw mode as initial setting (draw GDI rectangles instead of the de-
fault output method) add the following line to the ini-file:

[DRAW_ MODE]
UseGDIRect=1

Possible Options are 1 and 0 (= Compatible draw mode enabled or disabled).

» In Word, Excel and other office applications all barcode settings are saved and restored as
part of the document files. Therefore the draw mode setting will have no effect when opening
an existing document, but only when inserting a new barcode.

However this setting will change the draw mode setting effectively in TBarCode applications
like TBarCode for SAP, TFORMer, etc.

B.2 Site Lock (OCX only)

The site lock is provided for security reasons. It only applies to the TBarCode OCX when it is
scripted within Internet Explorer. With this option you can specify, which sites are allowed to
execute “critical” function calls on the control and which are not:

[DOMAIN LIST]
Site Lock=

Please refer to the TBarCode OCX Developer Reference (Introduction » Security) for more infor-
mation.

B.3 License TBarCode

In order to license TBarCode you can paste your license data in the ini-file. If you want to know how
to do this, please contact our support (mailto:barcode @tec-it.com).
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Appendix C: FAQ

The frequently asked questions are located on our web page http://www.tec-it.com/FAQ.

If you do not find the required answers, please feel free to contact our support team:
mailto:barcode@tec-it.com.
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